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2 Legal notes
Version 1.4, April 2000, Made in Germany.
© Copyright 1999/2000, Leica Microsystems Heidelberg GmbH.
All rights reserved.
No part of this publication may be reproduced or transmitted in
any form or by any means, electronic or mechanical, including
photocopying, recording, or storing in a retrieval system, or
translating into any language in any form without the express
written permission of Leica Microsystems Heidelberg GmbH or
its authorized agent.
DISCLOSURE
This document contains Leica Microsystems Heidelberg GmbH
proprietary data and is provided solely to its customers for their
express benefit of safe, efficient operation and maintenance of
the product described herein. Use or disclosure of Leica
Microsystems Heidelberg GmbH proprietary data for the purpose
of manufacture or reproduction of the item described herein, or
any similar item, is prohibited, and delivery of this document
shall not constitute any license or implied authorization to do so.
REVISIONS
Leica Microsystems Heidelberg GmbH reserves the right to
revise this document and/or improve products described herein
at any time without notice or obligation. Information and
specifications in this manual are subject to change without
notice.
WARRANTY
Leica Microsystems Heidelberg GmbH provides this publication
“as is” without warranty of any kind, either express or implied,
including but not limited to the implied warranties of
merchantability or fitness for a particular purpose. All reasonable
precautions have been taken in the preparation of this
document, including both technical and non-technical proofing.
Leica
Microsystems
Heidelberg
GmbH assumes
no
responsibility for any errors or omissions. Leica Microsystems
Heidelberg GmbH shall not be responsible for any direct,
incidental or consequential damages arising from the use of any
material contained in this document.
TRADEMARKS
Throughout this manual, trademarked names may be used.
Rather than put a trademark (™) symbol in every occurrence of
a trademarked name, we state that we are using the names only
in an editorial fashion, and to the benefit of the trademark owner,
with no intention of infringement.
SAFETY
This instrument is designed and manufactured to comply with
applicable performance standards for Class 1 laser products as
defined by USHHS (Class 1 laser products shall not emit
hazardous laser radiation during normal customer operation),
CDRH/FDA, OSHA and EN standards and regulations known to
be effective at the date of manufacture.
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Every possible hazardous situation cannot possibly be
anticipated, therefore, the user must exercise care, common
sense, and observe all appropriate safety precautions applicable
to Class IIIb lasers and high-voltage electrical equipment during
installation, operation and maintenance.
Deviation from published operating or maintenance procedures
is not recommended. Operation and maintenance procedure
changes are performed entirely at the user’s risk.
SOFTWARE LICENSE
The software described in this document is furnished under a
License Agreement which is included with the product. This
agreement specifies the permitted and prohibited uses of the
product.

3 Usage of this manual
We urge you to use this book, not just read it. To learn about the
Leica Confocal Software, use the book as a tutorial. We show
how to accomplish a variety of tasks. Work through the
instructions to learn. The book usually introduces a set of steps
to accomplish a particular task with a distinctive heading.

3.1 Do a task
Following the heading that introduces a task are either
sequential steps or optional steps, each with its distinctive style:
1. Numbered paragraphs, like this one, designate step-by-step
instructions. Follow them to learn how the tools work.
2. Menu commands are shown with an arrow between the single
items, for example, File→
→Save means you should pull down the
File menu and choose the Save option.
Paragraphs with a diamond bullet, like this one, are optional
steps.
Usually there is a sequence. Do one or more of the steps to
cause the designated action or actions.
We recommend that you review this book again after you have
used a Leica TCS SP II for a while. You will discover useful
features that you breezed over the first time.

3.2 Online help
Leica TCS SP II comes with a context sensitive online help
system that teaches you the different functions of the system.
To retrieve the contents of the online help system:
Choose Help → Contents. The online help system opens with
an activated CONTENTS window. It shows a collapsible table of
contents. Double-click an entry of the table of contents to show
the corresponding information.
To retrieve information using a keyword:
Choose Help→
→Index. The online help system opens with an
activated INDEX window. Enter a word you would like to look for
and the online help system will show the most similar keyword
defined.
To perform a full-text-search:
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Choose Help→
→Search. The online help system opens with an
activated SEARCH window. Enter a word you would like to look
for, press the LIST TOPICS button and the online help system
will show a ranked list of topics. On the right side of the field
where you enter the word, there is a fly out menu to perform fulltext search using logical operators.

4 Confocal imaging
4.1.1 What is confocal imaging
Conceptualized in 1953, the Confocal Laser Scanning
Microscopy has only in the past 10 years become a practical
technique. Today it is the technique of choice for biological
research, chemical analysis, and materials testing. An
instrument of this kind represents a „fusion product“ of
contributions from many fields: microscopy, laser technology and
optics for coherent light, video technology, electronics and
computer technology.
Confocal microscopy detects structures by collecting light from a
single focal plane of the sample, excluding light that is out of
focus.
In a point scanning confocal system, the microscope lenses
focus the laser light on one point in the specimen at a time (the
focal point). The laser moves rapidly from point to point to
produce the scanned image. Both fluorescent and reflected light
from the sample pass back through the objective.
The microscope and the optics of the scanner module focus the
light emitted from the focal point to a second point, called the
confocal point. The pinhole aperture, located at the confocal
point, allows light from the focal point to pass through the
detector. Light emitted from outside the focal point is rejected by
the aperture.
The confocal principle is illustrated schematically for the epiillumination imaging mode.
As in conventional epifluorescent microscopes, one lens is used
as both condenser and objective. The advantage is eliminating
the need for exact matching and co-orientation of two lenses. A
collimated, polarized laser beam from an aperture is reflected by
a beam splitter (dichroic mirror) into the rear of the objective lens
and is focused on the specimen. The reflected light returning
from the specimen passes back through the same lens. The light
beam is focused into a small pinhole (i.e., the confocal aperture)
to eliminate all the out-of-focus light, i.e., all light coming from
regions of the specimen above or below the plane of focus. The
achieved optical section thickness depends on several
parameters such as the variable pinhole diameter and the
wavelength. The in-focus information of each specimen point is
recorded by a light-sensitive detector (i.e., a photo-diode)
positioned behind the confocal aperture, and the analog output
signal is digitized and fed into a computer.
The detector is a point detector and only receives light from one
point in the specimen. Thus, the microscope sees only one point
of the specimen at a time as opposed to the conventional
microscope where an extended field of the specimen is visible at
one moment. Therefore, to obtain an image it is necessary either
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to move the illuminated point or to move the specimen. These
two possibilities have given rise to two different types of confocal
microscopes:
1.The stage-scanning type in which the microscope stage with
the specimen is moved in a scanning motion while the optics
remain stationary.
2. The beam-scanning or mirror-scanning type in which the
illuminated point is scanned over the fixed specimen by small,
fast, galvanometer-driven mirrors as used by LEICA.
The LEICA TCS SP II system makes it possible to image a
single, in-focus plane – horizontal or vertical – as well as a series
of planes. A single vertical section, or xz-scan, allows you to see
your sample as though from the side.
The advantage of having a stack of serial optical sections
through the specimen in digital form is that either a composite
projection image can be computed, or a volume-rendered 3-D
representation of the specimen can be generated on a graphics
computer.

4.1.2 Optical Resolution power
The term resolution refers to the ability to distinguish fine details
in a structure. An ideal microscope would have optics totally free
from aberrations of any kind. In such a hypothetical instrument
the resolving power would only be limited by diffraction. This limit
can be expressed as the minimum distance between two points
in the specimen for which they still appear as two points
(Raleigh’s criterion). Beyond this limit the points will merge and
cannot be resolved as two different points. This distance can be
calculated from the size of the diffraction image formed by an
infinitely small point in the specimen. It is equal to the radius of
the first minimum in this diffraction image. This in turn is related
to the numerical apertures of the objective and condenser. The
numerical aperture is defined by the refractive index of the lens
and the width of the cone of light that can pass through it.
In analogy with the reasoning above, the axial resolution can be
defined as the radius of the first minimum along the microscope
axis of the diffraction image of a point object. According to the
theory for such three-dimensional diffraction images, the radius
of the first axial diffraction minimum is approximately twice that
of the lateral. The axial resolution is thus approximately half of
the resolution within the plane of focus.
The LEICA TCS SP II is a no-compromise true point scanning
system with high sensitivity and theoretical maximum x-, y- and
z-resolution.
Scan resolution refers to image clarity as determined by the
number of pixels and pixel size. The smaller the pixel size, the
more easily two close objects can be distinguished. The scan
resolution is restricted to the maximum optical resolution power.

4.1.3 Detection
Confocal imaging, or to be more precise, the measurement of
the optical properties of tiny sub-volumes of a specimen, is
limited not only by the optical quality of the microscope. Other
limitations are:
The measurement of continuous specimen only in discrete subvolumes (because of sampling and digitalization).
• The accuracy with which the sub-volumes are defined,
determined by the scanning mechanism.
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•

The brightness of the light source in relation to the
reflectity of the specimen.
• The sensitivity and noise produced by the detector.
The detector is a central component of the confocal microscope,
too..

4.1.4 Image processing
In the first confocal microscopes, the detector was connected to
an oscilloscope with long-persistence phosphor which would
display an image as it was being scanned. In the instruments of
today, the signal is digitized and recorded in a computer. This
makes it possible to manipulate the image in a multitude of
ways:
Contrast enhancement by thresholds, linear contrast stretching
and gamma correction (curvature of the image intensity value
versus source intensity graph).
Superimposition of images in experiments.
Digital filtering for edge enhancement, smoothing, noise
suppression etc.
Reconstruction of three-dimensional views from stacks of
images of optical sections. This allows, for instance, an image of
an xz plane to be reconstructed from a stack of images of xy
planes. Complete 3D models of the specimen can also be
rendered and examined from any direction.
Assembly of digital movies from time-sequences of microscope
images.
Quantification and Measurements
Although these manipulations do not improve the quality of the
collected data, they serve the purpose of improving the visibility
and facilitating the qualitative interpretation of the data.

4.1.5 Light source
Lasers are favorable as light sources for confocal microscopy
because they feature high brightness, small divergence of the
beam, are easy to focus and are stable in intensity. The stability
is important for making quantitative measurements Therefore an
online reference correction is made for each pixel.

4.1.6 Integration
The Leica TCS SP II was designed as an integrated system.
Optical and mechanical elements work seamlessly with
computer hardware and software. The integrated Leica Confocal
Software package supports the complete imaging process, from
optical sectioning, through image processing and analysis (which
is the main application), to hard copy output.
•

5 Safety remarks
This section introduces you to standard safety precautions,
warnings and cautions.

5.1 General Safety Directions
Your safety is extremely important. Read and follow all warnings
and cautions in this book before handling and operating Leica
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equipment. You can be seriously injured, and equipment and
data can be damaged if you do not follow the safety warnings
and cautions.

5.2 Risk of Operation
The entire risk for the performance of the device is assumed
by the operator or the owner of the product.
The owner or operator will be fully liable for all consequences
which may result, if the device is opened by persons other than
authorized Leica service staff, if it is not serviced or maintained
properly or if it is used for purposes other than those described in
the accompanying documentation and the online help facility.
Leica Microsystems Heidelberg GmbH will not be liable for
damages resulting from non-observance of the above
information. The above information does not, in any way,
implicitly or explicitly, modify the warranty and liability clauses
contained in the general terms and conditions of Leica
Microsystems Heidelberg GmbH.

5.3 Warnings, Cautions, and Notes
The warnings, cautions, and notes in this manual use the
following format.

Danger
A warning alerts you of an operating procedure, practice,
condition, or statement that must be strictly observed to avoid
death or serious injury to the persons working on the equipment.

Caution
A caution alerts you to an operating procedure, practice,
condition, or statement that must be strictly observed to prevent
equipment damage or destruction, or corruption or loss of data.

Notes
Notes are statements that either provide extra information about
a topic or contain special instructions for handling a particular
condition or set of circumstances.

5.4 Laser Class
In order to take into account any possible danger resulting from
inadmissible usage we have assigned the Leica TCS SP2 to the
laser safety class IIIb. However, improper usage can lead to
conditions under which this laser class can no longer be
guaranteed. For this reason we are not able to generally declare
our system to belong to Class 1
This instrument is designed and manufactured to comply with
applicable performance standards for Class 1 laser products as
defined by USHHS (Class 1 laser products shall not emit
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hazardous laser radiation during normal customer operation),
CDRH/FDA and OSHA standards and regulations known to be
effective at the date of manufacture.
Hazardous situation cannot possibly be anticipated. Therefore,
the user must exercise care, common sense, and observe all
appropriate safety precautions applicable to Class IIIb lasers and
high-voltage electrical equipment during installation, operation
and maintenance. Deviation from published operating or
maintenance procedures is not recommended. Operation and
maintenance procedure changes are performed entirely at the
user’s risk.
The laser light emitted from the Leica TCS SP2 used in
accordance with the instructions is harmless.

5.5 Technical Safety Measures
In accordance with the laser safety directives EN 60825
(European standard) and CDRH (USA) Leica Microsystems
Heidelberg GmbH employs various safety measures. Warning
labels have been affixed near apertures or moveable parts
where exposure to laser light is possible.
Furthermore a laser-interlock-switch is installed.

Note
Note that it is a requirement of EN 60825-1: „Safety of Laser
Products, Part 1. Equipment classification, requirements and
user’s guide“, that for installations where class IIIb devices are
used, a Laser Safety Officer (or Laser Protection Advisor) should
be appointed. It is the laser safety officer’s responsibility to
review and designate appropriate controls for the use of the
equipment.

5.6 WARNINGS
Warning
Do not look directly into or at a reflection of the laser beam while
the laser is scanning. Long term exposure to the laser beam can
damage your vision. For the purposes of laser safety, a direct
laser beam which has been deflected from a mirror or polished
surface is considered to be as intense as the direct beam.

The user is responsible for the safe operation and maintenance
of this instrument at all times. Class 1 laser product and electrical
safety compliance is assured only when all safety devices,
interlocks, and laser containment systems are in serviceable
condition and operating. Disabled or damaged safety devices or
systems will expose personnel to lethal high-voltages and Class
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IIIb laser radiation of sufficient power to cause severe eye injury,
burns, and property damage.

Tampering with, or deactivation of, any safety system and/or
interlock terminates Class 1 laser product performance, will
expose personnel to hazardous Class IIIb laser radiation, bodily
injury, and void warranty coverage.

5.7 Power Cord Set Requirements
The power cord set supplied with your instrument meets the
requirements of the country where you purchased the
instrument. If you use the instrument in another country, you
must use a power cord set that meets the requirements of that
country.

Danger
This equipment is designed for connection to a grounded
(earthed) outlet. The grounding type plug is an important safety
feature. To reduce the risk of electrical shock or damage to the
instrument, do not disable this feature.

Caution
To reduce the risk of fire hazard and electrical shock, do not
expose the unit to rain or humidity. Do not open the cabinet. All
maintenance is to be performed by an authorized Leica
technician.

Do not allow any liquid to enter the instrument cabinet, or come
into contact with any electrical components. The instrument must
be thoroughly dry before you reconnect power, or turn the
instrument on

5.8 General Safety Notes
In accordance with general safety regulations as well as laser
device safety regulations comply with the following stipulations:
Observe the operating instructions!
Use the product only according to the information given in this
documentation and in the online help facility of the Leica
Confocal Software. Carefully read the operating instructions
before you start the system. As a preparation for your single
work steps always read the relevant description of function in the
online help and in particular observe the safety regulations
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indicated for handling the system. You can get an overview of
the single functions in the contents file of the online help.
Use the product only for purposes described in this
documentation and in the online help facility of the Leica
Confocal Software.
The system is designed for making confocal laser scan images
and quantitative measurements in the discipline of material
science. Using the Leica TCS SP2 for any other purposes or
applications is inexpert and inadmissible handling. The user
assumes the entire risk for all experiments with this system and
for the consequences resulting from such experiments. This is
particularly true if the device has been opened or modified by the
user.
Conduct safety inspection and checks on the instrument.
These inspections are defined by VDE (FDA in USA) and the
laser device safety regulations. The user must perform these
inspections as described. Only service engineers authorized by
Leica Microsystems Heidelberg GmbH are allowed to carry out
repair work.
Do not electrically connect the product to devices which are
not mentioned in this accompanying documentation.
Before connecting the product to any such devices, consult the
local Leica Service Agency or Leica Microsystems Heidelberg
GmbH directly.

5.9 Special Safety Remarks for Users
Leica Microsystems Heidelberg GmbH has done everything
possible to maximize user safety and minimize health risks
applying special safety measures in accordance with several
safety directives.
The user must operate the TCS SP2 in accordance with the
instructions in order to ensure safety. Several important points
are listed below:
Do not change objectives during scanning operations
How to change objectives:
• Ascertain that the Scan mode is switched off. The Scan
button must visibly released. Be sure that there is no
laser light in the focal plane. Close the safety shutter at
the tube.
• Turn the lens turret so that the lens to be exchanged
appears outside of the optical axis and points outwards.
Do not apply strong moments to the turret, as this may
reduce the resolution of the turret scan permanently.
• Screw in the new lens and turn the lens turret again into
the optical axis.
All unused positions on the objective nosepiece must be
capped.
Do not insert reflective objects into the beam path during
scanning operations.
Do not change specimen during scanning operations.
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How to exchange a specimen:
• Ascertain that the Scan mode is switched off. The Scan
button must visibly released. Be sure that there is no
laser light in the focal plane. Close the safety shutter at
the tube.
• Exchange the specimen.

5.10 Laser Safety
The word ‘LASER’ is an acronym for Light Amplification by
Stimulated Emission of Radiation. The first laser was
demonstrated in 1960 and used a ruby as the lasing medium.
Lasers have been used in many applications from surgery to bar
code readers at supermarket checkouts, from laser pointers to
CD players.
Lasers can produce a very intense and very narrow (collimated)
beam of electromagnetic radiation in the frequency range of 150
nm to 1 mm. This radiation is generally in the form of intense
visible light. Because laser light is not an ionizing type of
radiation, interaction with the body is generally at the surface.
The eye and the skin are critical organs for laser radiation
exposure, and the resultant effects vary depending on the type of
laser (wavelength of the radiation) and beam energy output.
Laser energy of the proper wavelength and energy may be
focused by the lens of the eye onto the retina causing severe
damage. If laser radiation is of high enough energy, skin burns
may also result if extremities or other body parts are placed in
the laser beam. The following table summarizes the various
regions of the electromagnetic spectrum produced by lasers and
the organs of concern if exposure occurs.
Spectrum Region

Wavelength Range

Organ Effected

UV-C 100 nm to 280 nm

All absorbed in cornea and conjunctiva

UV-B 280 nm to 320 nm

Almost all absorbed in cornea and
conjunctiva

UV-A 320 nm to 380 nm

Cataract formation

380 nm to 760 nm

Retina

IR-A 760 nm to 1400 nm

Retina, lens, skin

Infrared IR-B 1400 nm to 3000 nm

Cornea and skin

IR-C 3000 nm to 106 nm

Cornea
and skin

Ultraviolet

Visible

Lasers are often identified by type, i.e. Argon-Krypton,
wavelength(s), and Laser Hazard Classification. The Laser
Hazard Classification is determined by the wavelength(s),
maximum duration of exposure, and the average power output of
the laser.
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5.11 Laser Hazard Classification and
Laser Safety Control Measures
Note
Direct exposure of the eye by a laser beam should always be
avoided with any laser, no matter how low the power.
Class I
Exempt lasers that cannot produce a hazard.
Class II
Low power visible laser which, due to the reflex response, does
not normally present a hazard unless viewed directly.
Class IIIa
Lasers that normally do not produce a hazard if viewed
momentarily with the unaided eye; may produce a hazard if
viewed using collecting optics.
Class IIIb
Lasers that can produce an eye injury if viewed directly, including
intrabeam viewing of specular reflections.
Class IV
Laser that can produce an eye injury or skin burns from direct,
specular or diffuse reflections; may be fire and skin hazards.
Class I, II, and IIIa lasers should have a yellow and black
„Caution“ label, while Class IIIb, and IV lasers should have a red,
black, and white „Danger“ label.
Embedded systems:
Class II, III or IV lasers or laser systems contained in a protective
housing and operated in a lower classification mode may be
classified at a lower classification. Specific control measures
may be required to maintain the lower classification.

5.12 Laser Hazards

Danger

The danger from lasers can be divided into the following major
categories:
• Eye hazards such as retinal or cornea burns.
RETINAL INJURY IS PERMANENT
•
•
•

Skin hazards such as burns.
Electrical hazards from high voltage equipment.
Fire hazards.

6 Maintenance and cleaning
Please refer to the corresponding manuals for information on
how to maintain the conventional LEICA Research microscope.
The instructions and additional information relating to the
components of the TCS SP II confocal system are summarized
below.
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6.1 Selecting an installation site
Do not expose the system to draft. Therefore, do not install your
TCS SP II system next to elevators, air conditioners and other
inlets and outlets.

6.2 Protect the microscope against
dust and grease
When not in use, the system should be covered with a plastic foil
(part of delivery) or a piece of cotton cloth. The system should be
operated in a room which is kept as dust and grease-free as
possible. Dust caps should always be placed over the objective
turret positions when no objective is in place.

6.3 Be careful when using aggressive
chemicals
You must be particularly careful if your work involves the usage
of acids, lyes or other aggressive chemicals. Make sure to keep
such substances away from optical or mechanical components.

6.4 Cleaning the optical system of the
microscope
The optical system of the microscope must be kept clean. Under
no circumstances should users touch the optical components
with their fingers or anything which may bear dust or grease.
Remove dust by using an air puffer (not solvent based) or a fine,
dry hair pencil. If this method fails, use a piece of cloth,
moistened with distilled water. Persistent dirt can be removed
from glass surfaces by means of pure alcohol, chloroform or
naphtha.
If an objective lens becomes accidentally contaminated with
inappropriate immersion oil or mounting medium, contact your
next Leica representative for advice about cleaning with
solvents. Take this seriously, because some solvents may
dissolve the glue which holds the lens in place.

Caution
Do not open objectives for cleaning.
Oil should be removed from oil immersion lenses after use. Once
most of the oil has been removed with a clean tissue, a piece of
lens tissue should be placed over the immersion end of the lens.
A drop of recommended solvent should be applied, and the
tissue gently drawn across the lens surface. This should be
repeated as often as is necessary to attain total cleanliness. Use
a clean piece of lens tissue each time.

6.5 Cleaning the microscope surface
Use a linen or leather cloth (moistened with naphtha or alcohol)
in order to clean the surfaces of the microscope housing or the
scanner (varnished parts).

Caution
Never use acetone, xylol or nitro thinners as they attack the
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varnish.
All LEICA components and systems are carefully manufactured
on the basis of the latest production methods. If you encounter
problems in spite of our efforts, do not try to fix the devices or the
accessories yourself, but contact your Leica representative.

7 The Leica Confocal Software:
An overview
7.1 Starting the software
7.1.1 Requirements for starting the software
The LCS software is copy protected to prevent it from being used
on two computers at the same time. This protection system
allows all additional application packages to be used. To enable
the software, the provided dongle must be inserted into the
parallel port of your computer. The dongle does not affect the
functionality of the parallel port (e.g. for printing, etc.). To use the
software on a second computer, the dongle must be fitted to its
parallel port.

Note
If you remove the dongle from the confocal system control
computer, the software cannot be started, preventing operation
of the confocal system.
The LCS software can be started in two operating modes:
hardware mode and simulation mode. In hardware mode, all
hardware components are accessed and initialized by the
software. For this reason, you should switch on the hardware
first and then wait about 20 seconds before starting the software.
In simulation mode, the software runs independently of the
hardware. This mode is intended for secondary installations on
another computer, for example for training or offline analysis of
existing data.

7.1.2 Starting the software
Select Start|Programs|Leica Confocal Software. The initial
screen of the Leica Confocal Software appears. In this window,
one of three profiles can be selected.
Company
With this option, the Leica Confocal Software is started with the
default settings. In this mode, the configuration and position of
toolbars is fixed and cannot be changed.
Personal
In this mode, a user-specific configuration profile can be
selected. The user name depends on the account under which a
person logs on to the operating system. If the user does not yet
have a personal configuration profile, the default settings are
used.
Last Exit
With this option, the last used configuration profile is used.
For advanced users:
If you have several configuration profiles, you can load to these
at startup by clicking the button with the three small black dots at
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the lower right edge of the profile options. Here, you can also
reset your current personal configuration profile to the default
settings.
When you press the Start button, the Leica Confocal Software
starts with the selected configuration profile.

Note
If you do not press the Start button, the software will start by
itself after a specified time with the selected configuration profile.

7.2 The experimental concept of the
software
With the Leica Confocal Software, image data or the results of
image processing steps can be combined in groups. These
groups are referred to as "experiments" and are stored in a
specific file format (*.lei). In these experiments, original
experimental image data can be stored together with image
viewing data. For further details, see chapter "Organizing data by
grouping experiments".

7.3 Basic structure of the user
interface
The visual appearance of the Graphical User Interface (GUI)
depends to a large extent on the chosen configuration profile. It
does, however, contain a number of standard elements.
The following standard elements are common to all GUI
configurations:
The menu bar
The menu bar contains the File, View, Macro, Tools, Window
and Help menus. These menus contain commands and
information for viewing data, making changes to settings and
customizing the program for specific users. It does not contain
functions for the direct control of scan functions. These are
contained in the TCS menu (View→
→Menu→
→TCS Menu). The
menu bar itself cannot be configured.
The Viewer window (TCS_Viewer)
This window displays image data, experimental conditions and
user information. The image window can be configured (see
chapter "Modifying the user interface and defining user-specific
settings" on page 16). Beside confocal image records, the image
window also shows experimental data such as system settings.
An image window for a new experiment can be opened with File
→ New.
TCS menu (TCS_Menu)
The TCS menu contains the buttons for the individual device
functions. It is arranged in individual working steps. The number
of working steps varies depending on the installed software. The
default set of working steps consists of data acquisition
(Acquire), image viewing (View), surface reconstruction (3 D),
the measuring functions (Quantify), the image processing and
analysis functions (Process) and the documentation functions
(Annotate). If the TCS menu is not available in the current
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configuration profile, you can activate it with View → Menu →
TCS Menu.
The toolbars
Individual button arrangements can be set up for each individual
user. A key feature of the toolbars is that they can be toggled on
and off complete with all buttons. This is done with the menu
option View → Menu → Container.
Viewer window for documents (Experiment Overview)
In this window, existing experiments and their content are listed
in the form of a directory tree. The viewer window can be opened
with View → Experiment Overview.
Status bar
The status bar appears at the lower edge of the Leica Confocal
Software user interface. In it, the following information is
displayed:
• The progress when loading image data (progress bar)
• The software version number
• The name of the machine configuration (system type)
For details about individual functions, see chapter "Software
reference".

7.4 Opening records
7.4.1 Readable file formats
The following file formats can be opened and viewed with the
Leica Confocal Software
Experiments (*.lei)
This is a Leica-specific binary file format. Files of this format
contain data for complete experiments.
TIFF files (*.tif)
These are Leica image files in single and multiple tagged image
file format (TIFF). Both image files in the previously used TCS
formats and external files in RGB TIF format can be read.
Annotation files (*.ano)
This is also a Leica-specific binary file format. In these files,
annotation sheets are stored. The elements on the annotation
sheets, such as images, text and graphics, are each available as
individual objects.
When a file of this type is opened, both the image data and the
experiment settings are loaded.

7.4.2 Automatic reuse of instrument
parameters
With the Leica Confocal Software, the hardware settings saved
with experiments or single images can be carried over to a new
experiment. This allows subsequent experiments to be carried
out with the same settings. To carry over previous settings, open
the viewer window for the record whose settings you want to
reuse. Then click "Apply" (in the default configuration profile on
the toolbar).

Note
If you cannot find the "Apply" button in any of the open windows,
you

can

assign

the

button

to

any

window

with

Tools→Customize. In the dialog that opens, select the "File"
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category in the "Commands" tab. Left-click the "Apply" button
and keep the button pressed while pulling it to the window of
your choice. To insert the button in its current position, release
the mouse button.

7.5 Saving images
Individual images and experiments can be saved in the file
formats described in section "Readable file formats" above.
To save images and experiments, select File → Save. When an
experiment is first saved, the "Save as" dialog opens, where you
must enter a file name. You can also select a file format in this
dialog. Experiments can only be saved in the Leica-specific *.lei
format. When you are saving experiments, you may be able to
save existing individual images in *.tif or *.raw format.

Note
If the experiment or image has already been saved, the previous
data is overwritten each time the experiment or image is saved.
To prevent this, you must save the data under a new filename
with File →Save as.

7.6 Organizing data by grouping
experiments
The Leica Confocal Software allows single images, image series,
and the results of image processing steps to be combined in a
group (an experiment). The experiment overview window
provides an overview of all loaded experiments. If the experiment
overview window is not visible, you can open it with View →
Experiment Overview. With File → New and File →
New(Template) a new experiment can be created. In the same
way, existing files that are being opened are managed as
separate experiments.

7.7 Compiling experiments
Note

After you have created a new experiment with File→
→New or
File→
→New(Template), you can assign data to it.
Images acquired with the continuous scan function are
automatically overwritten the next time a scan is started. If you
want to permanently keep a single image as part of an
experiment, choose the single scan function.
An experiment contains data acquired with the single or series
scan function. If you perform image processing functions on a
record, you can also save the results as part of the experiment.
To do this, double-click the desired image or series in the
experiment overview. Now carry out the image processing
functions (e.g. maximum projection or topology image). Mark the
area within the Viewer window that you want to add to the
experiment. With the right mouse button (context menu), select
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Send to→
→Experiment. The Selection (raw) option creates a
copy of the raw data for the selected object as a new, separate
component of the experiment. The Selection (snapshot) option
creates an RGB image (no 3D data, photo only) of the selected
object as a new component of the experiment.

8 Starting the Operating System
Windows NT™
You don’t have to start Windows NT ™– it starts automatically
when you turn on your PC. You will first see a splash screen.
Next you have to log on to your computer. As you can see from
the instructions in the box, pressing the Ctrl, Alt and Delete keys
at the same time will log you on.
Once you press the Ctrl, Alt, and Delete keys, the Logon
Information dialog box is displayed.
Typing your password identifies you as a valid user for this
computer.
The default User name for the Leica TCS SP II system is " ".
Default password is " ". After being logged in you can change
your password by pressing Ctrl, Alt and Delete keys at the
same time.
Then click on change password. The Change Password dialog
box displays.
Type your current password in the Old Password field
(passwords are case sensitive, so be sure you use the right
case), then press the Tab key. Pressing the Tab key moves the
cursor to the next field.
Type your new password, then press the Tab key again.
Retyping the new password confirms that you aren’t making a
typing error. This is important since the characters you type
appear as asterisks on the screen.

Note
If you miss-type the confirmation password, you will see a
warning dialog. Try again!
Then click the OK button. Your new password will be in effect the
next time you log on.
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Caution
Do not forget your password if you set one! Without the right
password you can’t access your computer anymore.
The Welcome dialog box is now displayed. Take a moment to
read the „Did you know...“ tip and then click the Close button to
begin using Windows NT.

8.1 Using a Mouse
You need a mouse to work most efficiently in Windows NT. Here
are the mouse actions you need to know:
Point means to move the mouse pointer onto the specified item
by moving the mouse. The tip of the mouse pointer must touch
the item.
Click on an item means to move the pointer onto the specified
item and press and release the mouse button once. Unless
specified otherwise (i.e. right-click), use the left mouse button.
Clicking usually selects an item.
Double-click on an item means to move the pointer to the
specified item and press and release the left mouse button twice
quickly. Double-clicking usually activates an item.
Drag means to move the mouse pointer onto the item, hold
down the mouse button, and move the mouse while holding
down the button. Unless specified (i.e. right-drag), use the left
mouse button.

8.2 The Windows NT interface
The basic interface of Windows NT is called the „Desktop“,
which provides a background for the items it contains.
The initial icons on the Desktop allow the user to view and
interact with the system in a logical way.
The Windows NT screen contains many special elements and
controls. Here’s a brief summary:
The background on which all the pictures and boxes rest is the
desktop.
The Taskbar shows the windows and programs that are open.
You can switch between open windows and programs by clicking
the name on the Taskbar.
The Start button opens a menu system from which you can start
programs. Click on the Start button; then, click on your selection
from each menu that appears.
Some icons appear on your desktop. You can activate one by
double clicking on it.
We now take a brief tour of the items you see on the screen.
A standard desktop item is the My Computer icon. Doubleclicking this icon opens the My Computer window.
The ‘My Computer’ window gives you easy access to the major
components like hard and floppy disk drives of your computer
system or workstation. For example, by double-clicking the Hard
disk [C:] icon you can see the contents of your PC’s hard drive.
This allows the user to view local resources as objects. Access
to the Windows NT Workstation 4 control panel and print
support/control are also accessible from ‘My Computer’. If at
installation time you installed one of the additional local
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applications such as ‘Dial-Up Networking’ this will also appear
within ‘My Computer’.
You can use the Control Panel icon in the My Computer window
to view and change any system component. The Control Panel
contains numerous icons that allow you to control your system.
The particular icons that you see on your PC may be slightly
different from those illustrated, due to that fact that you may have
different hardware installed, and may or may not be connected to
a network or modem. You may also have different Windows NT
Workstation 4 options installed.
Double-clicking the Network Neighborhood icon displays the
Network Neighborhood dialog box which gives you information
about who and what is connected to your workstation. It provides
an easy mechanism for browsing any network systems and
resources that you may be able to connect to in a way that is
independent of the actual type of network vendor. Traditionally, if
a system needed to be simultaneously connected to different
types of network, the way in which each could be connected and
viewed would be vendor specific. Windows NT Workstation 4 is
capable of displaying a common view of your entire network
even though it may actually comprise resources from Windows
NT, Novell NetWare, Banyan Vines, or others!
The Inbox icon is used if Microsoft Exchange is active on your
system. Windows NT Workstation 4 has in-built electronic mail
services based on Microsoft Mail (MS Mail) and Microsoft
Exchange. If there is already an MS Mail post office on the same
network that the system is connected to, the Windows NT
Workstation 4 mail client can connect directly into it. The Inbox
lets you access your messages.
The Recycle Bin icon represents the holding place for deleted
items. As long as files are in the Recycle Bin they can easily be
recovered if they have been accidentally deleted. Windows NT
Workstation 4 will preserve files until the system runs out of free
disk space. When this happens Windows NT Workstation 4 will
prune the contents of the Recycle Bin on a first-in first-out basis.

Caution
Files that are overwritten due to an application using a duplicate
filename will not be saved to the recycle bin.
Double-clicking the Bin displays its contents. The empty window
confirms that there are no items in the Recycle Bin.

8.3 The Start menu
A single click of the left-hand mouse button on the Start button
will invoke the start menu and present you with the seven major
categorized options for starting work on the system.
A single click of the right-hand mouse button will invoke a small
but powerful control menu containing the options Open, Explore
and Find.
Their functionality is described as follows:

8.4 Starting a Program
The Start menu contains the various categories where your
applications and work are stored. You can move further into the
various subcategories by positioning the mouse over the
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category that you are interested in to automatically open the next
subcategory. You do not have to click the mouse!
The Programs command displays the Programs menu. This
menu lists all of the applications installed and available to you.
An arrow, meaning that there is a submenu follows some items.
Drag the mouse cursor over the Accessories command to see
its submenu. The Accessories submenu lists the set of Windows
NT built-in programs.
TIP: If you drag an object either from the Desktop or from the
Windows Explorer and drop it directly onto the Start button a link
to that object will automatically appear in the Start menu.
There are many ways to start a program. The simplest is here:
•
Click the Start button.
•
Click Programs.
•
Click on the group that contains the program you want
to start (for instance, LCS).
•
Click on the program you want to start (for instance,
Leica LCS).
Another way to start a program is to open a document that you
created in that program. The program automatically opens when
the document opens. Double-click on a document file in My
Computer or Windows Explorer to open it, or click the Start
button and select a recently used document from the Documents
menu.
You can also start a program by double clicking on its shortcut
icon on the desktop. Shortcut icons are links to other files. When
you use a shortcut, Windows simply follows the link back to the
original file.
Whenever you use a document or program frequently, you might
consider creating a shortcut for it on the desktop. To do so, just
use the right mouse button to drag an object out of Windows
Explorer or My Computer. On the menu that appears, select
Create Shortcut(s) Here. Some programs automatically create a
shortcut during their installation procedure.

Caution
Windows NT Workstation 4 does not actively track a link
between an original and a shortcut. For instance, if you create a
shortcut of a program, and subsequently move (rather than copy)
the original to a different folder, then the shortcut may no longer
function.
The Startup folder is special in one respect, any programs held
within it will start automatically when you start Windows NT
Workstation 4.
The Documents menu shows the names of the 15 files you
created most recently. You can open any of these files and its
related application at the same time by clicking the file’s name in
this menu.

Caution
Document files that are opened within an application (typically by
selecting the File/Open command within the application) will not
be displayed here. Only documents opened directly from the
Desktop will be displayed here.
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The Settings menu offers three commands for changing your
system’s settings. You can directly access the Control Panel and
Printing folders. Also accessible is the Task Properties window.
Being able to access the core system configuration utilities in this
way is particularly useful when an application is already in the
foreground and you want to make a quick change.
The Find command features an easy way to locate all system
resources. Within the Find category you can perform searches
for three distinct types of search which are described as follows:

8.5 The Taskbar
The Taskbar – positioned at the bottom of the screen – provides
a constant view of which applications are running on the system
and an easy way to switch between them. As you add to the
number of concurrently running applications the Taskbar
automatically re-sizes its iconized view of the applications to
ensure that they can always be seen. To switch from one
running program to another, simply click on the second program
as displayed in the Taskbar.
The Taskbar also provides constant additional information such
as the system time and volume control if you have a sound card
fitted, all of which can be further tailored by the user.

8.6 Setting the Time and Date
The current Date, Time and Time Zone information can be set
from the Date/Time icon within the Control Panel. This setting is
important since Windows NT stamps the date and time on all of
your files as you create and modify them. The two options can
be selected by clicking on the appropriate tab.
To change the Date and Time
Click on the appropriate date or use the controls to change the
month or year. The time can also be changed by first selecting
the digital display and then using the up and down arrows.
To change the Time Zone
Select the appropriate Time Zone from the drop down list at the
top of the screen. Notice that the option to automatically adjust
the clock for daylight savings time is selected. On some systems
you can also drag the highlighted area on the world map and
drop it on the correct location.
Changing the date and time information within Windows NT
Workstation 4 will update the battery backup CMOS clock in your
system.

Note
Depending on the shell configuration, systems connected to a
network may get a time and date update from a network server
every time they log on. If the servers time is incorrect your
workstations time will be wrong too. Please inform your network
manager.

8.7 Getting Help
Windows NT includes a powerful help system. In addition to Help
menus in every window, there is a standalone Help feature
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available from the Start menu. To access it, click your mouse on
the Start button, and click on Help.
There are three tabs in this box: Contents, Index, and Find. The
Contents tab appears on top first. To move to a tab, click on it.
Contents
The Contents tab displays individual Help topics. The topics are
organized into categories and are represented by small book
icons. Double-click on any book to open it. Sub-books and
documents appear. Double-click on sub-books and documents to
open them.
Index
The Index tab displays an index of all available topics. Type the
word you want to look up. The Index list scrolls to that part of the
alphabetical listing. When you see the topic on the list that you
want to read, double-click on it.
Find
The Find tab provides a text entry box for you to type the specific
word(s) or phrase you want to search for under Help, rather than
searching for information by category. The text entry box is
linked to a list of words in your Help files and any words or
phrases that match will be shown. You can specify more than
one word by separating words with a space. If you wish to
change a search option, select Options. The first time you click
on this tab, Windows tells you it needs to create a list. Click Next,
and Finish to allow this. Then you see the main Find tab. Type
the word(s) you want to find in the top text box. Then click a word
in the middle box to narrow the search. Finally, review the list of
help topics at the bottom, and double-click the one you want to
read.
When you’re done reading about a document, click Help Topics
to return to the main Help screen, or click Back to return to the
previous Help topic. Click the window’s Close button to exit Help.

8.8 Shut Down Windows NT
Always use the Shut Down command before you turn off your
PC. The Shut Down option allows the user to close the Windows
NT Workstation operating system and ensure all running
processes can halt cleanly and are given the chance to flush any
data that may be in cache memory out to the disk. Several
options are available when shutting the system down.

Caution
Powering down your computer without prior shutting it down may
result in severe data loss.

9 Help from the Internet
First contact your local Leica subsidiary or the local dealer.
You can also find information on Leica Microsystems Heidelberg
GmbH and confocal microscopy on our web site
http://www.llt.de.
Send email to support@llt.de.
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10 Softwarefunctions
10.1 Software functions for data
acquisition
10.1.1 Selecting an Objective

Function
Click the Objective button to open a list of objectives and select
an appropriate one for recording your images. This list shows
only the objectives that have been assigned to the up to seven
slots on the revolving nosepiece. You can assign objectives as
follows:
"

Select the Objective option from the Tools menu. A dialog window opens containing an
extensive list of objectives and the symbolic representation of the slots on the revolving
nosepiece.

"

Find in the list the objective that you are using and select it with the mouse. Click and hold
the left mouse button and drag the objective onto the symbol representing the slot in which
the objective is installed.

"

The assignment is saved in the software and the objective appears in the selection list,
which you can open by pressing the Objective button.

"

Repeat this procedure for every objective that you have installed in the revolving
nosepiece.
You can use the Add, Remove and Edit buttons in this dialog
window to add new objectives, remove objectives or edit existing
objective entries.

Note
The revolving nosepiece of DM RXA, DM RXE and DM IRBE
microscopes is triggered by the software so that the objective is
moved automatically into the beam path when you select an
objective with the Objective button or dialog window. With all
other microscope types the objective has not only to be assigned
in the software but also be moved manually into the beam path.

Additional Information
When selecting the correct objective for a specific application,
the objective's correction class (achromats, apochromats, fluorite
objectives and plan-objectives) and especially the magnification
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factor and the numerical aperture are of great significance. The
numerical aperture determines the resolution capacity of an
objective and is deduced from the angle of the light cone
accepted by the objective lens and the refractive index of the
medium between objective lens and specimen: NA = n*sin α
Objectives with greater magnification generally have larger
numerical apertures but smaller entrance pupils and therefore
can record light only from a relatively small scan field. Objectives
with larger apertures permit higher resolutions but allow less free
working distance. The following table illustrates this relationship:
Resolution
(xy)

Resolution
Air (z)

Resolution
Water (z)

Resolution
Oil (z)

Scan Field
Size (xy)

HC PL FLUOTAR 5x
0.15

1301

19410

25879

29559

3000

HC PL FLUOTAR 10x
0.30

651

4768

6407

7335

1500

N PLAN 20x 0.40

488

2630

3566

4093

750

N PLAN 50x 0.75

260

649

948

1108

300

PL APO 100x 1.40

139

319

209

236

150

Objective

Values in nm at wavelength λ 488 nm

Values in µm

Typical Applications
Dry objectives are typically used in materials science for the
examination of surface structures. When imaging layered
structures in which the material layers have different refractive
indices, immersion objectives are most suitable. With biological
specimens it depends on the specimen and the medium in which
it is embedded whether an oil-immersion objective or a waterimmersion objective should be applied. The highest resolution is
achieved, when the refractive indices of the immersion medium
or the specimen on the one hand and the objective medium on
the other are as homogeneous as possible.

10.1.2 The Electronic Zoom

Function
In confocal microscopy, the magnification of an image is
determined both by the objective and the electronic zoom. The
objective generates an intermediate image magnified based on
the objective's magnification factor. Additional magnification is
provided by the electronic zoom. At a zoom factor of 1 the
maximum scan field size is scanned with a specified number of
sampling points. If the zoom factor is set to 2, the same number
of points is used to scan a scan field with only half the length of a
side of the maximum scan field (1/4 the original scan field). This
achieves stronger magnification and thus better image
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resolution, because a smaller scan field is scanned with the
same frequency, which results in a higher density of data.
You can select one of the preset zoom factors in the dialog
window that is opened with the Zoom button. If you click Others,
there are two ways of specifying another zoom factor:
"

Use the mouse to move the slide on the scale. The corresponding value is shown in the
middle of the dialog window.

"

Double-click the boldface numerical value located in the middle of the dialog window. This
opens a second dialog window where you can enter an exact value.
You can also set the zoom factor using the corresponding rotary
knob of the control panel.
 see Controlling Functions from the Control Panel
Additional Information
While zoom factors from 1 to 36 can be set, the useful
magnification of the electronic zoom cannot be increased
infinitely. The limit is achieved with the smallest optically
resolvable distance, which is determined by the resolution
capacity of the objective. According to the Nyquist theorem the
smallest optically resolvable distance can be mapped without
loss of information if it is scanned with about 2 to 3 raster points.
If this scan frequency is exceeded with a relatively high zoom
factor and a selected scan format, further magnification is no
longer useful because no more optical details can be resolved
(empty magnification).
 see Selecting a Scan Format
 see Selecting an Objective

Note
With bleach-sensitive specimens it is advisable to restrict the use
of the electronic zoom to short time intervals. At high zoom
factors a section of the specimen is recorded with a relatively
higher scan frequency, and thus exposed to a high illumination
intensity. This can destroy the specimen photochemically (optical
bleaching), making it unfit.
Optimal Zoom Factors
The following table shows which zoom factors (marked red) - at
a given scan format and scan field size defined by the objective can be used to scan the specimen without loss of data:
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Objective
Magnification
20

40

100

Scan Format Zoom Factor

Scan Field
Size (µ
µm)

Resolution/
Scan
Frequency
Scan
(nm)
Frequency

Numerical Resolution at
Aperture
λ 488 nm
0,6

1,25

1,4

325

156

139

1024 x 1024

1
2
4
6

750
375
187
125

732
366
183
122

0,4
0,8
1,8
2,7

512 x 512

1
2
4
8
10

750
375
187
94
75

1465
732
365
183
146

0,2
0,4
0,9
1,8
2,2

200 x 200

1
2
4
8
16
32

750
375
187
94
47
23

3750
1875
935
470
235
115

0,1
0,2
0,3
0,7
1,4
2,8

1024 x 1024

1
2
4
6

375
187
94
62

366
183
92
60

0,4
0,8
1,7
2,6

512 x 512

1
2
4
8
10

375
187
94
47
37

732
365
183
92
72

0,2
0,4
0,8
1,7
2,2

200 x 200

1
2
4
8
16
32

375
187
94
47
23
12

1875
935
470
235
115
60

0,1
0,2
0,3
0,7
1,3
2,6

1024 x 1024

1
2
3

150
75
50

146
73
49

0,9
1,9
2,8

512 x 512

1
2
4
6

150
75
37
25

293
146
72
49

0,5
0,9
1,9
2,8

200 x 200

1
2
4
8
12

150
75
37
18
12

750
375
185
90
60

0,2
0,4
0,7
1,5
2,3

Note
The Leica Confocal Software provides three different zoom
features: the electronic zoom, the 3D zoom and the graphical
zoom.
 see Zooming the 3D View
 see The Viewer Options Dialog Window, Display Icon
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10.1.3 Setting the Detection Pinhole

Function
Clicking the Pinhole button opens a dialog window that you can
use to set the diameter of the detection pinhole. In the upper
right list field in the dialog window, select the units for displaying
the diameter. You can select from µm, Airy units and digital
values. There are two ways of specifying a value for the
diameter:
"

Use the mouse to move the slide on the scale that is displayed on the left in the dialog
window. The corresponding value is shown in the middle of the dialog window.

"

Double-click the boldface numerical value located in the middle of the dialog window. This
opens a second dialog window where you can enter an exact value.
The diameter of the detection pinhole must be set to the
currently used objective at all times. If you click the Airy 1 button,
the detection pinhole is set automatically to the optimal value of
1 Airy unit depending on the objective in use.
In addition to the numerical aperture of the objective and the
wavelength of the light, the detection pinhole also determines the
thickness of the optical sections.
Additional Information
The diameter of the pinhole is set optimally if it matches the
diameter of the Airy disc. The Airy disc refers to the inner, light
circle of the diffraction pattern of a point light source. The
diameter of the Airy disc, in turn, is also dependent on several
optical parameters and can be described for the Leica Confocal
System as follows:

To calculate the diameter of the Airy disc, you need the
excitation wavelength λ (if working with several wavelengths, a
mean value should be applied), the numerical aperture (NA) and
the magnifying factor (M) of the objective. The factor of 3.6 refers
to the magnification of other optical components belonging to the
Leica Confocal microscope.
If the pinhole is set to the Airy disc, light from outside the focal
plane is suppressed and the signal-to-noise ratio will be high.
These conditions allow the recording of optical sections of
minimum thickness. The wider the diameter of the pinhole, the
more light reaches the detector. The image becomes brighter but
also increasingly blurred because structures outside the focus
also appear in the image.
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Increasing the diameter of the pinhole above 1 Airy unit is
recommended only for detecting very weak signals.
Generally when recording material scientific specimens, enough
light is reflected into the detectors so that the detection pinhole
can be closed completely (i.e. set to the minimum diameter).

10.1.4 Selecting a Scan Format

Function
Clicking the Format button opens a dialog window that contains
a selection of various scan formats. Selecting the scan format
selects the image raster that will be used for recording the
images. The image raster refers to the number of points in the
three spatial directions that are to be scanned from the
specimen. Besides the numerical aperture of the objective and
the excitation wavelength, the scan format, together with the
electronic zoom, determines in large part the spatial resolution of
the recorded data.
Additional Information
When selecting the scan format, observe the influences between
the image raster and the resolution of the generated image.
According to the Nyquist theorem (or sampling theorem), a
structure can only be scanned without information loss if the
smallest optically resolvable distance is scanned with about 2 to
3 raster points. This optically resolvable distance, called lateral
resolution, depends on the numerical aperture of the objective
and the wavelength of the applied excitation light:

The following example should illustrate this relationship: You
have selected, for example, the PL APO 100x objective unit with
a numerical aperture of NA = 1.4 and a wavelength of λ = 488
nm. Based on these factors, the smallest optically resolvable
distance is determined as follows:

Based on this rough formula, the distance of the raster points
required to avoid information loss while recording is:

If however you select a scan format of 1024x1024, a PL APO
100x objective, which has a maximum
scan field size of 150 µm, would result in the following raster
point distance:
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To achieve the necessary raster distance of 47 nm, you now
have the option of increasing the scan format (for example to
2048x2048) or decreasing the scan field size using the electronic
zoom (zoom=2).
The current raster distance is displayed in the hardware legend.
In the legend the value is referred to as Voxel Size and is
calculated as soon as you change the scan format, the electronic
zoom or the objective.
 see The Electronic Zoom
 see Selecting an Objective

Note
When the sampling rate of 2 to 3 points is exceeded, it is
referred to as oversampling. In the case of oversampling, the
structure is fully mapped but no additional information is gained.
The disadvantage of oversampling is the long scanning time and
the danger of destroying bleach-sensitive specimens. When the
sampling rate is less than 2 to 3 points, it is referred to as
undersampling. In this case, there is the danger that not all
necessary information is sampled. The image might illustrate
structures that are not actually present in the specimen. This
effect is called aliasing.

10.1.5 Selecting a Scan Mode

Function
Clicking the Mode button opens a dialog window containing a list
of available scan modes. The scan mode determines which
optical levels of the specimen are to be scanned. Fundamentally,
horizontal xy-sections or vertical xz-sections can be recorded. To
generate a three-dimensional image of the specimen, the optical
sections are continued in the corresponding third direction in
space, thus recording a stack of individual images. In addition to
this, it is possible to add the factor of time or wavelength while
recording the images:
Mode

Function

xyz

An image stack is recorded from xy-sections in z-direction.

xzy

An image stack is recorded from xz-sections in y-direction.

xt

A line is recorded several successive times.

xyt

An xy-section is recorded several successive times.
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xzt

An xz-section is recorded several successive times.

xyzt

An image stack is recorded from xy-sections in z-direction several successive times.

xyλ

An xy-section is recorded at different wavelengths.

xzλ

An xz-section is recorded at different wavelengths.
All scan modes (with the exception of xt) are composed of at
least three dimensions. The unit will ignore the third and further
dimensions if you record using the continuous scan function or
the single scan function from one optical level only (xy or xz).

Note
The scan modes xzy, xzt and xzλ are only displayed in the list, if
you have previously selected the Galvo item using the Z-Scan
button. Likewise, the scan modes for a wavelength series xyλ
and xzλ are only displayed, if only one detector is activated in
the Beam Path Setting dialog window.

 see Selecting the Z-Actuator
 see Setting the Beam Path

10.1.6 Selecting a Scan Speed

Function
Clicking the Speed button opens a dialog window that you can
use to select from four different scan speeds:
Speed
200

Image lines per second

400

Image lines per second

800

Image lines per second

1000

Image lines per second
The data recording speed can be further increased in
combination with the bidirectional scan.
 see Unidirectional or Bidirectional Scan
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Additional Information
The faster the scan speed is, the shorter the dwell time of the
laser point. The scan format, i.e. the number of sampling points
on a line, must also be taken into consideration. The higher the
scan format at a constant speed is, the shorter the dwell time of
the laser point over a sampling point.
The longer the light point of the laser beam dwells over the
individual sampling points of the specimen, the more light is
detected by the detector. So using a lower scan speed results in
a better signal-to-noise ratio. The disadvantage of a lower scan
speed is that the relatively long impact of the light on the
specimen can bleach the specimen photochemically, making it
unusable. This is especially important with fluorescence
applications.

Note
If the speed is set to 800 or 1000, the maximum scan field can
no longer be scanned because of technical, device-related
reasons. The system switches automatically to zoom factor 2
and zoom factor 4 respectively.

10.1.7 Setting the Z/Y-Position

Function
Use the z/y-Position button to define the horizontal level (zposition) or vertical level (y-position) of the specimen in which
the images are to be recorded. If you want to record an image
series using the Series Scan function, you use the z/y-Position
button and the Begin and End buttons to define the begin and
end points of the image series.
 see The Series Scan Overview Dialog Window
Clicking the z/y-Position button opens a dialog window that
provides you with two ways of specifying a position value:
"

"

Use the mouse to move the slide on the scale that is displayed on the left in the dialog
window. The corresponding position value is shown in the middle of the dialog window.
Double-click the boldface position value located in the middle of the dialog window. This
opens a second dialog window where you can enter an exact value.
You can also set the z/y-position using the corresponding rotary
knob of the control panel.
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 see Controlling Functions from the Control Panel

10.1.8 Configuring a Time Series

Function
Click the Time button to open the Time Configuration dialog
window for setting up a time series recording. The parameters
you can set in this dialog window depend on the selected scan
mode. You can record a line (xt), a horizontal section (xyt), a
vertical section (xzt) or a stack of horizontal sections (xyzt) many
successive times interrupted by a certain time interval.

Note
The Time button is not enabled unless you have selected a scan
mode with time dimension using the Mode button.
 see Selecting a Scan Mode
With a time series using the xt scan mode the following
parameters are displayed in the dialog window:
∆T

Recording time for a line (cannot be adjusted by the user)

Lines

Number of recordings of the line

Lines per
page

Number of lines per virtual memory page

Pages

Number of virtual memory pages (is calculated automatically)

Complete
Time

Complete recording time, i.e. product of ∆T and number of recordings
Use the Calculate button to calculate how many virtual memory
pages result from a given number of lines per page.
With a time series using the xyt or xzt scan mode the following
parameters are displayed in the dialog window:

∆T

Recording time for one xy-section or xz-section plus pause interval

Frames

Number of recordings of the xy-section or xz-section

Complete
Time

Complete recording time, i.e. product of ∆T and number of recordings
With a time series using the xyzt scan mode the following
parameters are displayed in the dialog window:
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∆T

Recording time for one image stack of xy-sections plus pause interval

Stacks

Number of recordings of the image stack

Complete
Time

Complete recording time, i.e. product of ∆T and number of recordings
Each parameter can be calculated as a function of the other
parameters. When entering the values observe the special
operating principle of the dialog window. Clicking an entry field
deactivates it:

"

Click the parameter that is to be
corresponding entry field appears grey.

"

Now enter the values for the other parameters.

"

Click Apply to calculate the parameter. Clicking Reset
displays the last saved values.

calculated.

The

When you have finished configuring these settings, press the
Series Scan button.

10.1.9 Starting a Single Scan

Function
Use the Single Scan button to record a single image from a
single optical level in the specimen.
Before recording an image using the single scan function,
configure all required scan parameters using the Continuous
Scan function to ensure optimal image quality.
 see Starting a Continuous Scan
Typical Applications
The single scan function is designed for recording bleachsensitive specimens. Use this function in the case of bleachsensitive specimens not only for image recording, but also as an
alternative to the continuous scan function for setting the scan
parameters. The single scan function can also be used to check
the image section by zooming in on the scan field.
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10.1.10

Starting a Continuous Scan

Function
Use the Continuous Scan button to permanently record images
from a single optical level in the specimen. This does not
generate image series, since the image being generated always
replaces the previously generated image.
Press the button a second time to stop the continuous scan.
Additional Information
The unit applies the last used scan parameters automatically.
You can modify some of the parameters while the image is
being recorded. Others have to be configured before you start
the recording:
Before Recording

While Recording

Selecting the objective
Selecting the scan format
Selecting the scan mode
Selecting the scan speed
Selecting unidirectional or bidirectional scan

Setting the beam path
Setting the detection pinhole
Setting the electronic zoom
Setting the detectors
Adjusting the phase
Setting the z/y-position

The buttons of the functions that cannot be changed during
continuous scanning are disabled and appear gray.
Typical Applications
The continuous scan function is best used to optimize the image
quality for the first scan of a specimen. While the specimen is
being scanned continuously, you can modify the scan
parameters listed above and check the results directly in the
image.

Note
With bleach-sensitive specimens it is advisable to restrict the use
of the Continuous Scan function to short time intervals.
Subjecting the specimen to the continuous light of the laser can
destroy the specimen photochemically (optical bleaching),
making it unfit.

10.1.11
The Series Scan Overview Dialog
Window
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Function
This dialog window lets you define the begin and end points of
an image series and trace the recording of the individual
sections. The three-dimensional scan area is represented
graphically as a cube. Within this cube, a yellow square
represents the current z-position and y-position, a green one
represents the begin point and a red one the end point. The
corresponding position values are displayed to the right of the
cube. Set the begin and end point as follows.
"

Use the mouse pointer to drag the yellow square to the level in which the image series is
to begin.
Or click the z/y-Position button to open a dialog window where you can enter the values of
the z-position and y-position.

"

Click in the white box for the begin point. The corresponding position value appears and is
saved.

"

Use the mouse pointer to drag the yellow square to the level in which the image series is
to end.
Or click the z/y-Position button to open a dialog window where you can enter the values of
the z-position and y-position.

"

Click in the white box for the end point. The corresponding position value appears and is
saved.

"

The entire height of the image stack between the begin and end points is calculated and
displayed (Total).
Now click the Series Scan button. The dialog window stays open
and you can follow the process of the image series being
recorded.

Note
You can also define the begin and end points using the control
panel and the separate Begin and End buttons.
 see Defining the Begin Point for a Spatial Series
 see Defining the End Point for a Spatial Series
 see Setting the z/y-Position
Additional Information
The following additional parameters, which have to be set before
recording an image series, are specified in the Series Scan
Overview dialog window:
"

Scan mode (top line to the right of the graphic image)

"

Scan format (red digits at the upper edge of the cube)
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"

Number of optical sections (division between begin and end points)
The red number on the vertical edge of the cube represents the
the maximum travel of the z-actuator that cannot be changed.
 see Selecting a Scan Mode
 see Selecting a Scan Format
 see Defining the Number of Spatial Sections

10.1.12
Defining the Begin Point for a
Spatial Series

Function
Use the Begin button to define the begin point of a spatial image
series. First set the exact z-position or y-position using the z/yPosition button or on the control panel using the corresponding
rotary knob. Then click Begin. This saves the position value for
the begin point. The end point is set in the same manner.
 see Setting the z/y-Position
 see Controlling Functions from the Control Panel

Note
You can also set the begin and end points for a spatial series in
the Series Scan Overview dialog window. Open this dialog
window by pressing the Series button (the small button, not the
button that starts the Series Scan function).
 see The Series Scan Overview Dialog Window

10.1.13
Defining the Begin Point for a
Wavelength Series

Function
For a wavelength series, this function records a stack of
individual images, each of which are detected at a specific
wavelength, from a single, optical level. Use the Lambda Scan
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Begin button to define the wavelength at which recording should
begin.

Note
The Lambda Scan Begin button is not enabled unless you have
selected a scan mode with wavelength dimension using the
Mode button.

 see Selecting a Scan Mode
"

Press Beam to open the Beam Path Setting dialog window.

"

Activate a detector by clicking its corresponding check box. A cast shadow now links the
activated detector to the corresponding slide bar on the scale of the spectrum.

"

Double-click this slide bar to open the Range Properties dialog window, where you can
specify the detection bandwidth.

"

Drag the slide bar on the scale of the spectrum to the desired begin point. The left edge of
the slide bar represents the wavelength at which the recording is to begin.

"

Click Lambda Scan Begin to save the value.
The end point of a wavelength series is set in the same manner.
In addition, you also have to set the number of wavelength steps.
 see Defining the End Point for a Wavelength Series
 see Setting the Number of Wavelength Steps
Typical Applications
A wavelength series can be applied to determine the maximum
emission of a fluorochrome. This is useful because the Stokes
shift of the emission curve of a fluorochrome is dependent on
each specimen that is applied. This then allows you to set the
detection range precisely for a specific application.

10.1.14
Defining the End Point for a
Spatial Series

Function
Use the End button to define the end point of a spatial image
series. First set the exact z-position or y-position using the z/yPosition button or on the control panel using the corresponding
rotary knob. Then click End. This saves the position value for the
end point. The begin point is set in the same manner.
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 see Setting the z/y-Position
 see Controlling Functions from the Control Panel

Note
You can also define the begin and end points for a spatial series
in the Series Scan Overview dialog window. Open this dialog
window by pressing the Series button (the small button, not the
button that starts the Series Scan function).

 see The Series Scan Overview Dialog Window

10.1.15
Defining the End Point for a
Wavelength Series

Function
For a wavelength series, this function records a stack of
individual images, each of which are detected at a specific
wavelength, from a single, optical level. Use the Lambda Scan
End button to define the wavelength at which recording should
end:

Note
The Lambda Scan End button is not enabled unless you have
selected a scan mode with wavelength dimension using the
Mode button.

 see Selecting a Scan Mode
"

Press Beam to open the Beam Path Setting dialog window.

"

Activate a detector by clicking its corresponding check box. A cast shadow now links the
activated detector to the corresponding slide bar on the scale of the spectrum.

"

Double-click this slide bar to open the Range Properties dialog window, where you can
specify the detection bandwidth.

"

Drag the slide bar on the scale of the spectrum to the desired end point. The right edge of
the slide bar represents the wavelength at which the recording is to end.

"

Click Lambda Scan End to save the value.
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The begin point of a wavelength series is set in the same
manner. In addition, you also have to set the number of
wavelength steps.
 see Defining the Begin Point for a Wavelength Series
 see Setting the Number of Wavelength Steps
Typical Applications
A wavelength series can be applied to determine the maximum
emission of a fluorochrome. This is useful because the Stokes
shift of the emission curve of a fluorochrome is dependent on
each specimen that is applied. This then allows you to set the
detection range precisely for a specific application.

10.1.16
Defining the Number of Spatial
Sections

Function
Clicking the Sections button opens a dialog window that you can
use to select the number of horizontal xy-sections and vertical
xz-sections for recording a picture series. If you want to specify a
number of sections that is not listed, click the Others option. This
opens the Z/Y Configuration dialog window, which contains the
following data:
Parameter

Description

Image Dim. z
(µm)

The height of the entire image stack between the begin and end points of
the image series

# Sections

The number of configured sections

Step Size (µm)

The distance between two sections
Enter any desired value for the number of sections and the step
size in this dialog window. The value for the height of the image
stack cannot be altered, since this parameter is determined by
the begin and end points of the image series. The step size has
always to be a multiple of the minimum step size of the zactuator, so that certain combinations of values are only possible
if either the height of the image stack or the number of sections
is changed. Depending on which of the both Calculate buttons
you click, one of the two parameters is kept unchanged.
Calculating the number of sections with the priority for keeping
the height of the image stack unchanged:

"
"

Enter the desired step size in the Step Size field.
Then click the Calculate button next to the Step Size field.
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Calculating the number of sections with the priority for keeping
the number of sections unchanged:
"

Enter the desired step size in the Step Size field.

"

Then click the Calculate button next to the # Sections field.
Calculating the step size with the priority for keeping the height
of the image stack unchanged:

"

Enter the number of desired sections (whole numbers only) in the # Sections field.

"

Then click the Calculate button next to # Sections field.
Calculating the step size with the priority for keeping the number
of sections unchanged:

"

Enter the number of desired sections (whole numbers only) in the # Sections field.

"

Then click the Calculate button next to the Step Size field.
Clicking Reset displays the last saved values.
 see Starting a Series Scan
 see The Series Scan Overview Dialog
 see Selecting the Z-Actuator

10.1.17
Setting the Number of Wavelength
Steps

Function
For a wavelength series, this function records a stack of
individual images, each of which are detected at a specific
wavelength, from a single, optical level. The images are
recorded within a wavelength range, which is limited by the begin
and end points. Use the Lambda Steps button to define the
number of recordings that are to take place within this range.

Note
The Lambda Steps button is not enabled unless you have
selected a scan mode with wavelength dimension using the
Mode button.

 see Selecting a Scan Mode
 see Defining the Begin Point for a Wavelength Series
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 see Defining the End Point for a Wavelength Series
Typical Applications
A wavelength series can be applied to determine the maximum
emission of a fluorochrome. This is useful because the Stokes
shift of the emission curve of a fluorochrome is dependent on
each specimen that is applied. This then allows you to set the
detection range precisely for a specific application.

10.1.18

Starting a Series Scan

Function
Use the Series Scan button to create an image series. This
creates a multidimensional image data block of the specimen.
The available dimensions for recording an image series are the
three directions in space (x, y, z) as well as the dimensions of
time (t) and wavelength (λ). This allows you to record a threedimensional, spatial image stack consisting of xy-sections or xzsections with the additional factor of time or wavelength.

Note
Before recording an image series, configure all required scan
parameters using the Continuous Scan function to ensure
optimal image quality.

 see Starting a Continuous Scan
Before recording a spatial image series, configure the following
settings:
"

Select the scan mode using the Mode button.
 see Selecting a Scan Mode

"

Select the scan format using the Format button.
 see Selecting a Scan Format

"

Set the desired z-position or y-position using the z/y-Position button or by using the
corresponding rotary knob of the control panel.
 see Setting the z/y-Position
 see Controlling Functions from the Control Panel

"

Set and store the begin point for an image series using the Begin button or in the Series
Scan Overview dialog window.
 see Defining the Begin Point for a Spatial Series
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"

Set the desired z-position or y-position using the z/y-Position button or by using the
corresponding rotary knob of the control panel.
 see Setting the z/y-Position
 see Controlling Functions from the Control Panel

"

Set and store the end point for an image series using the End button or in the Series Scan
Overview dialog window.
 see Defining the End Point for a Spatial Series

"

Select the number of spatial sections using the Sections button.
 see Defining the Number of Spatial Sections
When you have finished configuring these settings, press the
Series Scan button.
You can track the recording process of the image stack in the
Series Scan Overview dialog window.
Before recording a time series, configure the following settings:

"

Select a scan mode with time dimension using the Mode button.
 see Selecting a Scan Mode

"

Select the scan format using the Format button.
 see Selecting a Scan Format

"

Set the desired z-position or y-position using the z/y-Position button or by using the
corresponding rotary knob of the control panel.
 see Setting the z/y-Position
 see Controlling Functions from the Control Panel

"

Set the number of recordings, the pause interval between scans and the complete
recording time.
 see Configuring a Time Series
When you have finished configuring these settings, press the
Series Scan button.
Before recording a wavelength series, configure the following
settings:

"

Select a scan mode with wavelength dimension using the
Mode button.
 see Selecting a Scan Mode

"

Select the scan format using the Format button.
 see Selecting a Scan Format

"

Define the wavelength at which you want the wavelength
series to begin.
 see Defining the Begin Point for a Wavelength Series

"

Define the wavelength at which you want the wavelength
series to end.
 see Defining the End Point for a Wavelength Series

"

Select the desired number of recordings between the begin
and end points of the wavelength series.
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 see Setting the Number of Wavelength Steps

10.1.19
Selecting Unidirectional or
Bidirectional Scan

Function
If you click the Unidirectional/ Bidirectional Scan button,
bidirectional scan mode is enabled. If this button is not clicked,
unidirectional scan mode is automatically set.
In unidirectional scan mode, each line is scanned from left to
right. No data is recorded while the laser beam is being guided to
the starting point of the next line. In bidirectional scan mode, the
first line is scanned from left to right and the second from right to
left. In other words, the return run, or flyback, of the laser beam
is implemented for recording data too, thus increasing the scan
speed when using bidirectional scan mode.
If bidirectional scan mode is active, you can double the scan
speed selected with the Speed button:
Unidirectional

Bidirectional

200

Currently
unavailable

Image lines per second

400

800

Image lines per second

800

1600

Image lines per second

1000

2000

Image lines per second

 see Selecting a Scan Speed
In order to accurately align the pixels of the forward sweep and
flyback, the phase between the forward sweep and the flyback
can be adjusted. To do so, use the Phase button or the
corresponding rotary knob of the control panel.
 see Setting the Phase
 see Controlling Functions from the Control Panel

Note
If the speed is set to 800 or 1000, the maximum scan field can
no longer be scanned because of technical, device-related
reasons. The system switches automatically to zoom factor 2
and zoom factor 4 respectively.
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Sind die Geschwindigkeitsstufen 800 oder 1000 eingestellt, kann
aus gerätetechnischen Gründen nicht mehr das maximale
Scanfeld abgetastet werden. Das System schaltet automatisch
auf den Zoomfaktor 2 respektive Zoomfaktor 4.

10.1.20

Adjusting the phase

Function
Recording images in bidirectional scan mode can result in a
phase shift between the forward sweep and flyback of the
scanning beam. Click the Phase button to open a dialog window
which you can use to correct the shift:
"

Use the mouse to move the slide on the scale until the pixel shift in the image disappears.
You can also adjust the phase using the corresponding rotary
knob of the control panel.
 see Controlling Functions from the Control Panel
Additional Information
For each zoom factor, a phase adjustment has already been
carried out by the factory, and the corresponding values have
also been set. Based on the temperature response of
mechanical and electronical devices, a slight deviation in the
adjusted standard values can result during operation, which can
be readjusted with this function.

10.1.21

Rotating the Scan Field

Function
The Scan Field Rotation button allows you to rotate the scan
field. This neither rotates the specimen nor the direction of the
scanner, but rather the intermediate microscopic image.
The angle of rotation is steplessly variable between -10 and
+100 degrees. The original position (0 degrees) is based on a
predefined reference position in the scan head. When the unit is
switched on, it automatically relocates to this reference position.
Typical Applications
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This function is useful to align textures on surfaces or elongated
biological structures relative to the observer.

10.1.22
Applying the Parameter Setting of
an Experiment

Function
Use the Apply button to use the hardware settings of a previous
experiment for recording a new experiment. This lets you
configure the settings for new image recordings with a single
click with the scan parameters that have been optimally
configured for a previous application.
"

Activate the image data block that is configured with the settings you want to apply to the
new experiment.

"

Click the Apply button.

10.1.23
Recording an Image Using the
Averaging Method

Function
The Average button applies an averaging method to the image
recording. In this case, every individual image, i.e. every xysection or xz-section, is scanned several times. For every
sampling point, the arithmetical average is calculated from the
repeatedly measured intensity values and represented in the
result image. The method used here determines a consecutive
average. This means every image recorded after the first image
is calculated with the results of the previously displayed image
and is displayed in the result image (dynamic average).
Clicking the Average button opens a dialog window that you can
use to set how often a section is to be scanned. You can select
from 1 to 64 scan repeats.
Typical Applications
Recording an image using the averaging method is primarily
useful for suppressing noise. In fluorescence microscopy, weak
fluorescent specimens result in little light reaching the detector.
The resulting low photon count leads to noisy images. In such
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cases, you can improve the signal-to-noise ratio by carrying out
multiple recordings and determining averages of the image.

Note
Recording an image using the averaging method is not
recommended

for

bleach-sensitive

specimens.

Repeated

recordings and the resulting length of subjection to light can lead
to the destruction of the specimen.

10.2 Softwarefunctions for data display
10.2.1 The Viewer Window

The default setting of the Viewer window consists of three main
areas. The image window (4), in which the recorded images are
displayed, is located in the middle. Button pads (1) and (2) can
be arranged to the left and below the image window and the
Experiment legend (3) to the right of it. It is possible to select
other default layouts of the Viewer window and save userdefined configurations of it.
 see Saving the Viewer Window as a Template
Button Pads (1) and (2)
By default, the button pad to the left of the image window
contains the buttons for image viewing functions and the button
pad below the image window contains the buttons used for
scrolling through the individual images of an image series. Both
button pads can be moved within the Viewer window or removed
from it as separate windows. To do so, click on the double-lined
edge of the button pad and drag it while keeping the mouse
button depressed to the desired position.
Image Window (4)
If you place the mouse pointer at any position within the image
window and then press the right mouse button, a context menu
containing the following commands opens:
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Send to "Experiment

Command

Function

"Selection (raw)

This copies the raw data of a selected area in
the image window as a new image in the
current experiment.

"Selection

(snapshot)

"Printer

This creates a new image in the current
experiment from the snapshot of a selected
area in the image window.

"All (snapshot)

This creates a new image in the current
experiment from the snapshot of the entire,
current image window.

"Selection

This prints the area selected in the image
window.

"All

This prints the entire, current image window.

Left buttons

This shows or hides the button pad to the left
of the image window.

Bottom buttons

This shows or hides the button pad located
below the image window.

LUT

This shows or hides the color look-up tables
of the current image.

Legend

This shows or hides the Experiment legend.

Full screen

This enlarges the Viewer window to full
screen.

Viewer Options

This opens the Viewer Options dialog
window.

The color look-up tables (5) are displayed as color bars to the
right of the image window. If you hold the mouse pointer over a
color bar, grab points appear at the top and bottom of the color
bar. You can use these grab points to limit the current color lookup table to a specific intensity range and to load a second color
look-up table. This allows you to increase the contrast of the
image graphically.
"

Drag the top grab point down or the bottom grab point up.

"

Double-click the area above or below the corresponding grab point.

" The Select LUT's dialog window opens so that you can select a second color look-up table.
"

The upper and lower intensity ranges are represented in the colors of the second color
look-up table.
 see Selecting Color Look-Up Tables (LUT)
The Experiment Legend (3)
Various image parameters of an image recording are registered
in the Experiment legend. To select the parameters that you
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want displayed, click any area of the legend. This opens a list of
all available entries. Then select the desired entry. If you hold the
mouse pointer over any area within the Experiment legend and
press the right mouse button, a context menu containing the
following commands opens:
Command

Function

"Edit

This opens the Edit Legend dialog window, where you can specify a
title for the legend, specify the number of legend entries or Clear all
entries.

"Activate

This displays the Experiment legend in the Viewer window.

"Remove

This deletes the current Experiment legend.

Add Experiment tab

This creates a new Experiment legend in the Viewer window.

Experiment

The Hardware Legend
The hardware settings for image recording are registered in the
Hardware legend. To open the legend, select the Hardware
Legend option from the View menu. To select the entries that
you want displayed in the legend, click the Edit button. This
opens the Edit Legend Entries dialog window:
"

The Available Entries list box shows all available entries. Select the entries that you want
displayed in the legend. Then click Add to carry the selected entries over into the Show
entries list box.

"

The Show entries list box contains the entries that are to be displayed in the legend. Use
the Remove button to remove entries from being displayed in the legend.

"

Use the Move up and Move down buttons to shift one or more than one entry up or down
in the list.

"

You can use the Edit grid color and Edit background color buttons to modify the color of
the frame and background of the legend.
The Hardware legend is aligned automatically along the right
edge of the user interface. You can change however the size
and position of the legend as desired:

"

To change the width of the legend, use the mouse pointer to drag the edge to the position
you desire.

"

To change the position of the legend, double-click on the double-lined edge of the legend
or click the# icon once. This releases the legend from the user interface, turning it into a
window. Now you can drag the legend to any position by pressing and holding the left
mouse button.
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Note
If the legend has been enlarged to cover the entire width of the
user interface, you first have to shrink the height of it in order to
drag it back to the edge of the user interface.
Option New Window
You can open a second Viewer window containing the same
image as the currently open Viewer window by clicking the New
Window option in the Window menu. This command does not
create a new experiment, but rather opens a second view of the
current image data. This feature is useful for viewing different
representations of the same image data at the same time.
Sequential numbers are added behind the file extension to
distinguish between the resulting copies of the current Viewer
window.

10.2.2 The Viewer Options Dialog Window, 3D
Icon
Function
Click on Viewer Options in the View menu to open a dialog
window where you can modify the basic settings for various
functions. The left side of this dialog window shows the icons
corresponding to the functions and the right side shows the
related registers. When you open the dialog, it contains the icons
of the functions that you are currently using. Click Show all to
view all icons.
The Navigation register displays the numerical values of the
actions that are carried out using the Rotate, Move and Zoom
buttons (and the mouse pointer).
Use the Rotation field to tilt a 3D view in all three spatial
directions by modifying the angular degrees of the three axes.
The 3D view is rotated around a fixed point, which is located in
the center of the image. To best understand the rotation function,
modify the angle of one axis at a time, while leaving the other
two axes set to 0.
Rotation

Function

X from 0° to 45°

The 3D view is rotated 45° around the fixed point in the direction of the
negative z-axis.

Y from 0° to 45°

The 3D view is rotated 45° around the fixed point in the direction of the
negative x-axis.

Z from 0° to 45°

The 3D view is rotated 45° around the fixed point in the direction of the
negative y-axis.
 see Rotating the 3D View
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Use the Translation field to shift a 3D view to the right or left, up
or down and enlarge or shrink it by modifying the coordinate
values. Use the dot as the decimal placeholder.
Translation

Function

X

Positive values shift the 3D view to the right, negative to the left.

Y

Positive values enlarge the 3D view, negative shrink it.

Z

Positive values shift the 3D view up, negative down.
Use the Predefined field to change the viewing perspective of the
image to Top view or Side view by clicking these buttons
respectively.
 see Moving the 3D View
 see Zooming the 3D View
In the Display register, click one of the listed commands to
show or hide the corresponding graphic element of the 3D view
in the Viewer window:

Graphic
Elements

Function

Show LUT

Show the selected color look-up table on the z-axis.

Show scale

Show the scale.

Show bounding
box

Show the bounding box, which limits the measurement volume.

Show axes

Show the coordinate axes.

Show data during
3D motion

Show the image data while the 3D view is being rotated, shifted, enlarged
or shrunken.

10.2.3 The Viewer Options Dialog Window,
Display Icon
Function
Click on Viewer Options in the View menu to open a dialog
window where you can modify the basic settings for various
functions. The left side of this dialog window shows the icons
corresponding to the functions and the right side shows the
related registers. When you open the dialog, it contains the icons
of the functions that you are currently using. Click Show all to
view all icons.
In the Settings register select the Display field to zoom in on
and zoom out of the image displayed in the Viewer window using
the graphical zoom function.
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n-1

Zooms in on the image by displaying n pixel as 1 pixel in the result image.

Automatic

The image is displayed in the original size.

1-n

Zooms out of the image by displaying 1 pixel as n pixel in the result image.

Note
The Leica Confocal Software provides three different zoom
features: the graphical zoom, the 3D zoom and the electronic
zoom.

 see Zooming the 3D View
 see The Electronic Zoom
In the same register click one of the boxes to show or hide the
corresponding graphic element in the Viewer window:
Scale

Displays a scale bar with unit of length in the Viewer window.

Grid

Applies a grid to the image displayed in the Viewer window.

The length of the scale bar is calculated depending on the selected objective, electronic
zoom and beam expander.
You can use the Movie register to set the speed for running the
film sequence of an image series. You can choose speeds from
6 images per minute to 25 images per second.
"

Use the mouse to drag the slide on the scale to the desired
value.
 see Starting and Ending a Film

10.2.4 The Viewer Options Dialog Window,
Surface Icon
Function
Click on Viewer Options in the View menu to open a dialog
window where you can modify the basic settings for various
functions. The left side of this dialog window shows the icons
corresponding to the functions and the right side shows the
related registers. When you open the dialog, it contains the icons
of the functions that you are currently using. Click Show all to
view all icons.
In the Render Mode field of the Visualization register, you can
select whether the 3D view is to be generated in surface,
wireframe or isolines mode:
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Render Mode

Function

Surface

The blank spaces between the pixels are filled in with surface.

Wireframe

All pixels are linked with lines, while the blank spaces remain free.

Isolines

Pixels that correspond to values of the same intensity are surrounded by a
curve.
In the Projection Type field, you can select the perspective to be
used for displaying the 3D view:

Projection Type

Function

Perspective

The 3D view is displayed in central perspective.

Parallel

The 3D view is displayed in parallel perspective.
In the Stretch Height (factor) field you can vary the scaling factor
in the z-direction, thus stretching or shrinking the height of the
3D view.
Use the Downsample rate field to reduce the density of data of
the 3D view to increase the speed of image processing. At a
pixel density of 1:1, all measured intensity values are displayed
in the image. At a pixel density of 1:2, only every second
measured intensity value is used in the image.
Use the Isoline Interval field to define a distance for separating
the individual isolines in µm. This allows you to limit the number
of isolines in the 3D view.
Use the Isoline Detail Level field to enter a limiting value,
specifying that only isolines of a particular length are to be
displayed in the 3D view. This limits the displayed isolines to
those which correspond to an intensity value that has a specific
frequency of occurrence.
 see Creating the 3D View
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10.2.5 Viewing Detection Channel 1

Function
Clicking the Channel 1 button displays the image data that have
been recorded in detection channel 1 in the Viewer window. You
can assign any of several color look-up tables to the detection
channel. This setting can be changed both in the result image
and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening
the dialog window:
"

Click the Select Look-up Tables button.

"

Hold the mouse pointer over any position in the Viewer window.
Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.
 see Selecting Color Look-Up Tables (LUT)

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.
 see Setting the Beam Path

10.2.6 Viewing Detection Channel 2

Function
Clicking the Channel 2 button displays the image data that have
been recorded in detection channel 2 in the Viewer window. You
can assign any of several color look-up tables to the detection
channel. This setting can be changed both in the result image
and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening
the dialog window:
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"

Click the Select Look-up Tables button.

"

Hold the mouse pointer over any position in the Viewer window.
Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.
 see Selecting Color Look-Up Tables (LUT)

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.
 see Setting the Beam Path

10.2.7 Viewing Detection Channel 3

Function
Clicking the Channel 3 button displays the image data that have
been recorded in detection channel 3 in the Viewer window. You
can assign any of several color look-up tables to the detection
channel. This setting can be changed both in the result image
and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening
the dialog window:
"

Click the Select Look-up Tables button.

"

Hold the mouse pointer over any position in the Viewer window.
Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.
 see Selecting Color Look-Up Tables (LUT)

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.
 see Setting the Beam Path
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10.2.8 Viewing Detection Channel 4

Function
Clicking the Channel 4 button displays the image data that have
been recorded in detection channel 4 in the Viewer window. You
can assign any of several color look-up tables to the detection
channel. This setting can be changed both in the result image
and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening
the dialog window:
"

Click the Select Look-up Tables button.

"

Hold the mouse pointer over any position in the Viewer window.
Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.
 see Selecting Color Look-Up Tables (LUT)

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.
 see Setting the Beam Path

10.2.9 Viewing Detection Channel 5

Function
Clicking the Channel 5 button displays the image data that have
been recorded in detection channel 5 in the Viewer window. You
can assign any of several color look-up tables to the detection
channel. This setting can be changed both in the result image
and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening
the dialog window:
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"

Click the Select Look-up Tables button.

"

Hold the mouse pointer over any position in the Viewer window.
Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.
 see Selecting Color Look-Up Tables (LUT)

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.
 see Setting the Beam Path

10.2.10
Selecting Color Look-Up Tables
(LUT)

Function
Use the Look-up Tables button to open a dialog window, which
you can use to assign color look-up tables to the five detection
channels. The color look-up tables can be configured both in the
result image and while the image is being recorded:
"

Click the detection channel to which you want to assign a new color look-up table in the
Select Channel field.

"

Select the desired color look-up table in the Select LUT field.

"

Click Apply to check the results in the Viewer window.
It is also possible to open the Select LUT's dialog window from
the Viewer window.

"

Hold the mouse pointer over any position in the Viewer window. Then push the right
mouse button. Click on the LUT item in the context menu that appears.

" The color bars for the active detection channels appear in the Viewer window to the right of

the image window. Double-click one of the color bars.
Loading a second color look-up table
If you hold the mouse pointer over a color bar, grab points
appear at the top and bottom of the color bar. You can use these
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grab points to limit the current color look-up table to a specific
intensity range and to load a second color look-up table:
"

Drag the top grab point down or the bottom grab point up.

"

Double-click the area above or below the corresponding grab point.

" The Select LUT's dialog window opens so that you can select a second color look-up table.
"

The upper and lower intensity ranges are represented in the colors of the second color
look-up table.

Note
This method of assigning color look-up tables only influences the
currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog
window are applied again.

 see Setting the Beam Path
Typical Applications
Generally the selection of a suitable color look-up table for a
specific use depends on the user's own judgment and needs.
Experience shows however that certain color look-up tables are
particularly useful for specific uses.
Color Look-Up Table

Application

Green

This is commonly used for recording
specimens that have been marked
with FITC, Cy2, DTAF or other
similar fluorochromes, which emit
within the green spectral range.

Red

This is commonly used for recording specimens that have been
marked with TRITC, Texas Red, Cy3, Rodamin or other similar
fluorochromes, which emit within the red spectral range.

Blue

This is commonly used for recording specimens that have been
marked with UV fluorochromes such as DAPI or Hoechst or other
similar fluorochromes, which emit within the blue spectral range.

Gray

This is commonly used for displaying transmission recordings.

P. Color 1, 2, 3, 4, 5, 6

This is commonly used for recording specimens that have been
marked with pH-sensitive or ion-sensitive fluorochromes and for
displaying time series.

These are recommended for generating topographical images,
Geo (Land), Geo (Sea)
Geo (Land & Sea) i.e. for mapping surface structures. Geo Land & Sea is especially
R&B
useful for visualizing depths and graduations.
Glow,
These are recommended for optimizing image contrast (the
Glow (Over),
offset and gain of the detectors). Glow Over highlights in blue
Glow (Under),
intensities at the upper end of the table while Glow Under
Glow (Over & Under) represents in green intensities at the lower end of the table. Glow
Over and Under is a combination of these two color tables.
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Cyan, Magenta, Yellow These are recommended for printing images. The CMY(K) colors
are generally used for the printer system color output. RGB
colors such as the other color look-up table used here are
applied generally for color representation on monitors. Because
these two color systems vary greatly, the colors in the CMY(K)
representation can differ strongly from those used in the monitor
representation.
All color look-up tables are also available with inverse color flow,
meaning high intensities are represented as dark and low
intensities light.

10.2.11

Viewing a Single Image

Function
Click the Single button to view only one detection channel or
several detection channels in only one image in the Viewer
window. The following display modes are available depending on
the other options you enable simultaneously.
Button Combination

Display

Only the selected detection channel is displayed;
Single + Channel 1 / 2 / 3 / 4 / 5 for an image series, the first image of the selected
detection channel is displayed.

Single + Gallery + Channel 1 / 2 / 3 / 4 / 5

All individual images in an image series are
displayed for the selected detection channel only.

Single + Overlay + Channel 1 / 2 / 3 / 4 /
5

A single overlay image is generated from all
selected detection channels; for an image series,
the first image of each selected detection channel
is used.

Single + Gallery + Overlay + Channel 1 /
2/3/4/5

Based on the number of individual images in an
image series, overlay images are generated from
all selected detection channels.

Note
The Single and Tiled buttons cannot be enabled simultaneously
because they carry out opposing functions.
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10.2.12

Viewing a Multiple Image

Function
If you click the Tiled button, the detection channels are displayed
separately in the Viewer window. The following display modes
are available depending on the other options you enable
simultaneously.
Button Combination

Display

Tiled + Channel 1 / 2 / 3 / 4 / 5

All selected detection channels are displayed
separately; in the case of image series, the first
image in each is applied.

Tiled + Gallery + Channel 1 / 2 / 3 / 4 / 5

All individual images in an image series are
displayed for all selected detection channels.

All selected detection channels are displayed both
separately and, in an overlay image, together. In
Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5
the case of image series, the first image in each is
applied.
All individual images of an image series are
Tiled + Gallery + Overlay + Channel 1 / 2
displayed both separately for all selected detection
/3/4/5
channels and, in overlay images, together.

Note
The Tiled and Single buttons cannot be enabled simultaneously
because they carry out opposing functions.

10.2.13

Viewing a Multiple Image

Function
If you click the Tiled button, the detection channels are displayed
separately in the Viewer window. The following display modes
are available depending on the other options you enable
simultaneously.
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Button Combination

Display

Tiled + Channel 1 / 2 / 3 / 4 / 5

All selected detection channels are displayed
separately; in the case of image series, the first
image in each is applied.

Tiled + Gallery + Channel 1 / 2 / 3 / 4 / 5

All individual images in an image series are
displayed for all selected detection channels.

All selected detection channels are displayed both
separately and, in an overlay image, together. In
Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5
the case of image series, the first image in each is
applied.
All individual images of an image series are
Tiled + Gallery + Overlay + Channel 1 / 2
displayed both separately for all selected detection
/3/4/5
channels and, in overlay images, together.

Note
The Tiled and Single buttons cannot be enabled simultaneously
because they carry out opposing functions.

10.2.14

Viewing an Overlay Image

Function
Click the Overlay button to display all selected detection
channels together in an overlay image in the Viewer window.
The following display modes are available depending on the
other options you enable simultaneously.
Button Combination

Display

Single + Overlay + Channel 1 / 2 / 3 / 4 /
5

A single overlay image is generated from all
selected detection channels; for an image series,
the first image of each selected detection channel
is used.

Gallery + Single + Overlay + Channel 1 /
2/3/4/5

Based on the number of individual images in an
image series, overlay images are generated from
all selected detection channels.

All selected detection channels are shown
Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5 separately as well as together in an overlay image.
In an image series, the first image is used.
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All individual images of an image series are
Tiled + Gallery + Overlay + Channel 1 / 2
displayed both separately for all selected detection
/3/4/5
channels and, in overlay images, together.
Use the Viewer Options dialog window to select from three
methods of color mixing for generating an overlay image:
"

From the View menu, select Viewer Options.

"

Click the Images icon and then click the Overlay register.
 see The Viewer Options dialog window, Images Icon

10.2.15

Viewing the First Image of a Series

Function
You can view the individual images of an image series as a film
sequence. Click First to jump to the first image in the series.

Note
If the Gallery button is enabled, the First and Last, Next and
Previous and Play/Stop buttons are disabled and displayed in
gray. The Gallery button is used to show all of the individual
images of an image series and does not allow film sequence
mode.
Ist die Taste Gallery angeklickt, sind die Tasten First und Last,
Next und Previous und Play/Stop grau unterlegt und können
nicht betätigt werden. Mit der Taste Gallery werden alle
Einzelbilder einer Bildserie eingeblendet, und können somit nicht
als Filmsequenz abgespielt werden.

10.2.16

Viewing the Next Image in a Series

Function
You can view the individual images of an image series as a film
sequence. Click Next to jump to the next image in the series.
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Note
If the Gallery button is enabled, the Next and Previous, First and
Last and Play/Stop buttons are disabled and displayed in gray.
The Gallery button is used to show all of the individual images of
an image series and does not allow film sequence mode.

10.2.17
Viewing the Previous Image in a
Series

Function
You can view the individual images of an image series as a film
sequence. Click Previous to jump to the previous image in the
series.

Note
If the Gallery button is enabled, the Next and Previous, First and
Last and Play/Stop buttons are disabled and displayed in gray.
The Gallery button is used to show all of the individual images of
an image series and does not allow film sequence mode.

10.2.18

Viewing the Last Image of a Series

Function
You can view the individual images of an image series as a film
sequence. Click Last to jump to the last image in the series.

Note
If the Gallery button is enabled, the First and Last, Next and
Previous and Play/Stop buttons are disabled and displayed in
gray. The Gallery button is used to show all of the individual
images of an image series and does not allow film sequence
mode.
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10.2.19

Starting and Ending a Film

Function
You can view the individual, recorded images of an image series
as a film sequence. Use the Play/Stop button to start and stop
the film. The speed of the film, i.e. the number of individual
images per unit of time, is variable and can be set in the Viewer
Options dialog window:
"

From the View menu, select Viewer Options.

"

Click the Display icon and then on the Movie register.
 see The Viewer Options Dialog Window, Display Icon

Note
If the Gallery button is enabled, the Play/Stop, First and Last,
Next and Previous buttons are disabled and displayed in gray.
The Gallery button is used to show all of the individual images of
an image series and does not allow film sequence mode.

10.2.20

Viewing a Series Image

Function
If you click the Gallery button, all of the individual images in an
image series are displayed in the Viewer window. The following
display modes are available depending on the other options you
enable simultaneously.
Button Combination

Display

Gallery + Single + Channel 1 / 2 / 3 / 4 / 5

All individual images in an image series are
displayed for the selected detection channel only.
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Gallery + Single + Overlay + Channel 1 /
2/3/4/5

Based on the number of individual images in an
image series, overlay images are generated from
all selected detection channels.

Gallery + Tiled + Channel 1 / 2 / 3 / 4 / 5

All individual images in an image series are
displayed for all selected detection channels.

All individual images of an image series are
Gallery + Tiled + Overlay + Channel 1 / 2
displayed both separately for all selected detection
/3/4/
channels and, in overlay images, together.

10.2.21

Projecting an Image Stack

Function
Use the Projection function to select or calculate specific
intensity data from an image stack, i.e. a series of xy or xzsections, and display them in a two-dimensional image. This
function examines the sampling points (voxels) that are
superimposed along the z-axis throughout all optical sections.
From each of these columns of sampling points, the intensity
value that is met by the selection criterion or the calculated
intensity value is displayed in the two-dimensional projection
image as the representative of all values within the column.
Three different projection types are available: the maximum
projection, the mean projection and the transparent projection.
"

The maximum projection uses the maximum intensity value as the representative.

"

The average projection uses the arithmetical mean of the intensity values as the
representative.

"

The transparent projection uses a weighted mean of the intensity values as the
representative. The weighting is composed of two factors. The first factor is the result of
the ratio of each measured intensity value to the maximum possible intensity (scaling
factor). The second factor takes into account the weight of the previously measured
intensity value. The higher the intensity of the previously measured sampling point, the
greater the weight is and the less the subsequently measured sampling points will
influence the calculation.
Use the Viewer Options dialog window to select one of the
projection types and configure any necessary options:

"

From the View menu, select Viewer Options.

"

Click the Images icon and then click the Projections register.
 see The Viewer Options Dialog Window, Images Icon
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Note
Note the difference between a maximum projection and a
topographical

image,

which

is

generated

from

intensity

maximums. In a maximum projection, the intensity maximums
are assigned color values directly. In a topographical image
based on intensity maximums, the intensity maximums are
assigned real z-positions of the individual sampling points first
and then are color-coded.

10.2.22

Creating a Topographical Image

Function
Use the Topography function to select specific intensity data
from an image stack, i.e. a series of xy or xz-sections, and
transfer them into a two-dimensional topographical image. This
function examines the sampling points (voxels) that are
superimposed along the z-axis throughout all optical sections.
From each of these columns of sampling points, only the
intensity value that is met by the selection criterion is displayed
in the two-dimensional topographical image as the
representative of all values within the column.
You can make your selection based on either the maximum
intensity or the center of mass of the measured intensities. If you
want to represent the intensity maximums in the topographical
image, only the sampling point at which the maximum intensity
was measured is selected. When determining the center of
mass, a mean value is calculated from all superimposed
sampling points (the center of mass of the area that is limited by
the curve of the measured intensity values).
The intensity maximum or center of mass is then assigned the
real z-position of the corresponding sampling point and then
color-coded. Based on this assignment, a topographical image
maps the real surface structure of the specimen. Using the
default settings, higher structures appear light and deeper
structures dark.
Use the Viewer Options dialog window to set the selection
criterion for the topographical image:
"

From the View menu, select Viewer Options.

"

Click the Images icon and then click the Topography register.
 see The Viewer Options Dialog Window, Images Icon
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By applying a second step, you can display the topographical
image as a three-dimensional graphical image using the 3D
View function.
 see Creating the 3D View
Typical Applications
Displaying the image data in a topographical image is especially
informative in material scientific research. For the application of
quantification
functions,
the
topography
function
is
indispensable.

10.2.23

Viewing the Original Image

Function
Click the Original button to reset a projection image or
topographical image. The Viewer window then displays the
recorded raw data of the image again.

10.2.24

Creating the 3D View

Function
Use the 3D View button to display a two-dimensional data record
three-dimensionally. When viewing an image series, the data
record of the series that is currently being viewed in the Viewer
window is always the one applied. You can display a single xysection or xz-section from the raw data or a result image, such
as a topographical image or projection image, in the 3D view.
Depending on the dimension represented or calculated in the
source image, either intensity values or height values are
mapped to the z-axis of the 3D view when the 3D view is
generated.

Note
The spatial representation of intensity in a 3D view leads easily
to the assumption that the topography of the specimen is being
represented. Note however that you can only display the real
surface structure of a specimen if you have generated a
topographical image first.
 see Creating a Topographical Image
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The 3D view can be generated in three different modes: surface,
wireframe or isolines. Set the display mode in the Viewer
Options dialog window:
"

From the View menu, select Viewer Options.

"

Click the Surface icon and then the Visualization register.
 see The Viewer Options Dialog Window, Surface Icon

Note
A separate 3D view is created for each detection channel.
Therefore it is not possible to generate a single 3D view from
one overlay image (Overlay button).

10.2.25

Rotating the 3D View

Function
Use the Rotate button to rotate a 3D view in all three spatial
directions. Note that the 3D view is rotated around a fixed point,
which is located in the center of the image.
"

Hold the mouse pointer over any position in the 3D view.

"

Press and hold the left mouse button.

"

Move the mouse pointer in the direction in which you want to rotate the 3D view.

Note
While the 3D view is being turned, the resolution of the image is
decreased in order to speed up processing. When the left mouse
button is released, the image is displayed with its original
resolution.
As an alternative to rotating a 3D view manually, the Viewer
Options dialog window also provides the option of specifying the
angles of rotation for the three spatial axes:
"

From the View menu, select Viewer Options.

"
"

Click the 3D icon and then click the Navigation register.
You can then specify the angles of rotation for all three axes in the Rotation field.
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 see The Viewer Options Dialog Window, 3D Icon

10.2.26

Moving the 3D View

Function
Use the Move button to shift a 3D view
"

Hold the mouse pointer over any position in the 3D view.

"

Press and hold the left mouse button.

"

Move the mouse pointer in the direction in which you want to move the 3D view.

Note
While the 3D view is being moved, the resolution of the image is
decreased in order to speed up processing. When the left mouse
button is released, the image is displayed with its original
resolution.
As an alternative to moving a 3D view manually, the Viewer
Options dialog window also provides the option of specifying the
coordinate values for the position of the image:
"

From the View menu, select Viewer Options.

"

Click the 3D icon and then click the Navigation register.

"

Modify the coordinate values for the x-axis and z-axis in the Translation field.
 see The Viewer Options Dialog Window, 3D Icon

10.2.27

Zooming the 3D View

Function
Use the Zoom button to magnify and shrink continuously a 3D
view while maintaining the aspect ratio. This function only
adjusts the scale of, i.e. zooms, the generated image. It cannot
be used to improve its resolution.

Version: RK26042000
Page 70

To zoom in on the 3D
view

Click anywhere inside the image window of the Viewer window and,
while pressing the left mouse button, drag the mouse pointer toward
the lower edge.

To zoom out of the 3D
view

Click anywhere inside the image window of the Viewer window and,
while pressing the left mouse button, drag the mouse pointer toward
the upper edge.

Note
While the 3D view is being zoomed, the resolution of the image
is decreased in order to speed up processing. When the left
mouse button is released, the image is displayed with its original
resolution.
As an alternative to zooming a 3D view manually, the Viewer
Options dialog window also allows you to change the zoom scale
by specifying numerical values:
"

From the View menu, select Viewer Options.

"

Click the 3D icon.

" You can then vary the zoom factor in the Navigation register by changing the y value in the

Translation field.
 see The Viewer Options Dialog Window, 3D Icon

Note
The Leica Confocal Software provides three different zoom
features: the 3D zoom, the electronic zoom and the graphical
zoom.

 see The Electronic Zoom
 see The Viewer Options Dialog Window, Display Icon
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10.3 Software functions for
measurements and analysis
10.3.1 Calculating a Histogram

Function
Use the Histogram function to graphically display the frequency
at which a specific dimension occurs. The histogram is
calculated from the data record selected in the Viewer window.
The data record can be a single image or an image series from
raw data or a processed image. Depending on the dimension
represented in the image, either the distribution of intensity
values (I) or height values (µm) is calculated in the histogram.
Clicking the Histogram button opens the Histogram viewer
window, which displays a histogram curve for each detection
channel and subsequent statistical calculations:
Parameter
# Pixel

Meaning

Formula

The total number of pixels that are included in the calculation of the
histogram. This corresponds to the configured scan format.

Mean

The arithmetical mean value

Maximum

Maximum value

Max (I)

Minimum

Minimum value

Min (I)

Variance

Variance

Average
Deviation

Average deviation

Standard
Deviation

Standard deviation
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Mean Energy

Average image energy

Root Mean
Square (RMS)

Root mean square value

Skewness

Skewness of the distribution

Some of the parameters are specified in scientific exponential
notation, e.g. Pixel = 3.28e+005 = 327680 (corresponds to a
scan format of 640 x 512).

Note
Using the maximum and minimum values of intensity, the gain
values and offset values can be optimally configured for the
detectors.

10.3.2 Measuring a Profile in a Single Image

Function
Use the Profile function to measure a specific dimension over a
line segment and display it graphically. The profile is measured
from the data record selected in the Viewer window. The data
record can be a single image or an image series from raw data
or a processed image. Depending on the dimension represented
in the image, either a measured curve of intensity values (I) or
height values (µm) is calculated.
When you click the Profile button, the line segment to be
measured appears in the Viewer window as a white line in the
image. You can change the length and position of the line
segment by clicking the line and, while clicking and holding the
grab point with the left mouse button, dragging it to the desired
position. The Profile viewer window opens, too, which displays a
profile curve for each detection channel and subsequent
statistical calculations:
Parameter

Meaning

Length

The length of the measured
section

Formula
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Mean Amplitude

The arithmetical mean

Maximum
Amplitude

Maximum value

Max (I)

Minimum
Amplitude

Minimum value

Min (I)

Average Deviation

Average deviation

Standard
Deviation

Standard deviation

Variance

Variance

Some of the parameters are specified in scientific exponential
notation, e.g. Variance = 1.88e+004 = 18800.

10.4 Softwarefunctions for
documentation of data
10.4.1 Creating an Annotation Sheet

Function
Use the Annotation button to open a window in which you can
prepare recorded images for presentation purposes. If you have
opened the annotation sheet, the Snap, Line, Rectangle and
Text buttons are also enabled. Use these buttons to copy the
image loaded in the Viewer window into the annotation sheet, to
highlight specific areas of the copied image with lines and
rectangles and to enter an image comment into a text field.
 see Copying an Image
 see Drawing a Line
 see Drawing a Rectangle
 see Creating a Text Field
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If you hold the mouse pointer over the annotation sheet and
press the right mouse button, a context menu containing the
following commands appears:
Command

Function

Line

Use this to insert a line of default size onto the annotation sheet.

Rectangle

Use this to insert a rectangle of default size onto the annotation sheet.

Text

Use this to insert a text field with a default font onto the annotation sheet.

Zoom

Use this to select from four magnifications for viewing the annotation sheet.

Grid

This displays a grid on the annotation sheet, which cannot be printed.
The Line, Rectangle and Text commands can be activated both
from the context menu and by clicking their corresponding
buttons.
Saved annotation sheets are given the *.ano file extension.

10.4.2 Copying an Image onto the Annotation
Sheet

Function
If you click the Snap button, the image loaded in the Viewer
window is copied onto the annotation sheet. If you mark the
copied image and then press the right mouse button, a context
menu containing the following commands appears:
Command

Function

Original size

This displays the image in its original size.

Fit to page

This enlarges the image to the size of the annotation sheet.

Bring to front

This brings the image to the foreground.

Send to back

This sends the image to the background.

Delete

This deletes the image.
You can change the size of the image by dragging one of the
image grab points. To move the image without changing its size,
mark the image and move it while pressing the left mouse
button.

Note
The Snap button can be applied only if a annotation sheet has
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been opened using the Annotation button first and the Viewer
window has then been clicked.

10.4.3 Drawing a Line on the Annotation
Sheet

Function
Use the Line button to draw a line on the annotation sheet. On
the annotation sheet, click the position where you want the line
to begin. Keeping the left mouse button depressed, drag the
mouse pointer across the page to the position where you want
the line to end. If you mark the line and then press the right
mouse button, a context menu containing the following
commands appears:
Command

Function

Style

This opens a dialog window where you can configure the style, thickness and
length of the line.

Color

This opens a dialog window for selecting a color for the line.

Bring to front

This brings the line to the foreground.

Send to back

This sends the line to the background.

Delete

This deletes the line.
You can change the length of the line by dragging one of its grab
points. To move the line without changing its size, click the
center grab point and move the line while pressing and holding
the left mouse button.

Note
The Line button can be applied only if the annotation sheet has
been opened using the Annotation button first.
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10.4.4 Drawing a Rectangle on the
Annotation Sheet

Function
Use the Rectangle button to draw a rectangle on the annotation
sheet. On the annotation sheet, click the position where you
want the corner of the rectangle to be. Keeping the left mouse
button depressed, drag the mouse pointer across the page to
define the size of the rectangle. If you mark the rectangle and
then press the right mouse button, a context menu containing
the following commands appears:
Command

Function

Style

This opens a dialog window where you can configure, among other options, the
style and thickness of the line.

Color

This opens a dialog window for selecting a color for the rectangle.

Bring to front

This brings the rectangle to the foreground.

Sent to back

This sends the rectangle to the background.

Delete

This deletes the rectangle.
You can change the size of the rectangle by dragging one of the
image grab points of the rectangle. To move the rectangle
without changing its size, click in the middle of the rectangle and
move it while pressing and holding the left mouse button.

Note
The Rectangle button can be applied only if the annotation sheet
has been opened using the Annotation button first.
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10.4.5 Printing

Function
You can trigger the print command either by clicking the Print
button or from the Printer Selection dialog window. To open this
dialog window, select the Print option in the File menu. The
image loaded in the Viewer window or an annotation sheet can
be printed.
When you initiate the Print command, the image currently loaded
in the Viewer window or the currently open annotation sheet is
printed using the default printer and default page layout. You can
change these default settings in the Printer Selection dialog
window to suit your needs. Use the following buttons provided in
the dialog window to do so:
Button

Function

Printer setup

This opens the dialog window for selecting a printer and changing the
printer settings.

Print

This prints the image or the annotation sheet.

Background color

Use this to open a dialog window for selecting a background color for the
page.

Center on page

This centers the image on the page.

Fit to page

This option changes the size of the image to fit the size of the printable
area.

Aspect ratio

The height-to-width ratio remains the same when the size of the image
changes.
Use the Image field to change the height (Size Y) and width
(Size X) of the image and to define a top margin (Offset Y) and a
left margin (Offset X). The image size and margins cannot be
modified if the Fit to page option is enabled. If you have enabled
Center on Page, you can change the size but not the margins.
Check the results of your settings in the Print Preview field. Use
the Page field to specify the height and width of the printable
area (which is not identical to the paper size). The two bottom
lines of the dialog window display the currently installed printer
and configured paper size.

Note
Close the Printer Selection dialog window by clicking OK to save
the new settings for the active Viewer window. This allows you to
store different printer settings and page layouts for different
images. However, these settings are not permanent and are lost
when you exit the Leica Confocal Software.
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10.5 Softwarefunctions for data
handling
10.5.1 Opening a File

Function
With the Leica Confocal Software, you can open the following file
types using the Open button:
File Type

Description

Experiment (*.lei)

A Leica-specific, binary data format. When the experiment is loaded,
both the image data and the experiment settings are loaded.

Annotation sheet
(*.ano)

A Leica-specific, binary data format. The elements on the annotation
sheet, such as images, texts and graphic images, are each available
as individual objects.

Tiff files (*.tif)

These are Leica image files in single and multi Tiff format. External
files in RGB-Tiff format can be loaded as well.

 see Creating an Experiment
 see Creating an Annotation Sheet
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10.5.2 Saving a File

Function
Click the Save button to save the data of the current experiment
(*.lei) or the current annotation sheet (*.ano).
If you use the Save button to save an experiment or annotation
sheet for the first time, the Save As dialog window opens.

Note
It is easy to mistakenly overwrite your original data using the
Save function. To avoid doing so, use the Save As function to
save an experiment, which has already been saved once or
more, under a new name.

 see Saving a File As...

10.5.3 Saving a File As

Function
Use the Save As button to save an experiment (*.lei) or
annotation sheet (*.ano) while giving it a specific name and file
type.
When saving an experiment, a folder is created at the file level
with the name of the experiment. This folder then contains the
description file (*.lei) for the experiment as well as the individual
image files. The format of the description file is Leica-specific
and binary. This file contains the parameter settings and the
color information (in the form of color look-up tables) for each
image belonging to the experiment.
The image files of an experiment can be saved in tif or raw
format. The standard format, tif, also contains the experiment
settings and the color information for the images. In the raw
format, just the image data is saved.
Typical Applications
The advantage of the raw format is the smaller file size, which
however is only significant for image recordings with relatively
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small amounts of data. For example if you record an image
series with a large number of individual images but at a low scan
format, you can save and open it faster in raw format than in tif.

10.5.4 Saving All Files

Function
Use the Save All button to save several experiments (*.lei) and
annotation sheets (*.ano) one after the other while giving them a
specific name and file type.
When saving an experiment, a folder is created at the file level
with the name of the experiment. This folder then contains the
description file (*.lei) for the experiment as well as the individual
image files. The format of the description file is Leica-specific
and binary. This file contains the parameter settings and the
color information (in the form of color look-up tables) for each
image belonging to the experiment.
The image files of an experiment can be saved in tif or raw
format. The standard format, tif, also contains the experiment
settings and the color information for the images. In the raw
format, just the image data is saved.
Typical Applications
The advantage of the raw format is the smaller file size, which
however is only significant for image recordings with relatively
small amounts of data. For example if you record an image
series with a large number of individual images but at a low scan
format, you can save and open it faster in raw format than in tif.

10.5.5 Creating an Experiment

Function
Click the New Experiment button to open a new Viewer window,
which creates a new experiment. An experiment is a file that
consists of one ore more individual images or image series. This
allows you to keep several images, each recorded using different
scan parameters, or edited versions of images in one
experiment. The format of the experiment file (*.lei) is Leicaspecific.
The Experiment Overview Viewer Window
To open the Experiment Overview viewer window, select the
Experiment Overview option from the View menu. This viewer
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window displays the recorded images in a directory tree. Every
newly created experiment appears in this viewer window with a
file name consisting of Experiment followed by a sequential
number and the *.lei extension. You can change file names and
file extensions using the Save and Save as buttons.
 see Saving a File
 see Saving a File as...
Individual images that you have recorded using the Single Scan
function are entered into the directory tree with the name Image
followed by a sequential number. Image series that you have
recorded using the Series Scan function are given names
consisting of Series and a sequential number.
If you mark the name of an individual image or an image series
and then press the right mouse button, a context menu
containing the following commands appears:
Command

Function

Activate

This displays the selected file in the Viewer window.

New Window

This opens a second viewer window for the currently loaded image.

Delete

This deletes the individual image or image series.

Properties

This displays file properties and certain scan parameters in a dialog window.
The Experiment Overview viewer window automatically appears
at the left edge of the user interface. You can change however
the size and position of the viewer window as desired:

"

To change the width of the viewer window, use the mouse pointer to drag the edge to the
position you desire.

"

To change the position of the viewer window, double-click on the double-lined edge of the
window or click the# icon once. This releases the viewer window from the user interface.
Now you can drag the viewer window to any position by pressing and holding the left
mouse button.

Note
If the viewer window has been enlarged to cover the entire width
of the user interface, you first have to shrink the height of it in
order to drag it back to the edge of the user interface.
Ist

das

Ansichtsfenster

über

die

gesamte

Breite

der

Bedienoberfläche vergrößert, lässt es sich nur wieder an die
ursprüngliche Stelle am Rand positionieren, wenn Sie zuerst die
Höhe des Fensters verkleinern und es dann erst an den Rand
verschieben.
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10.6 Softwarefunctions for
customization
10.6.1 User Customization of the Software

10.7 Directories containing userspecific data
Once the users have been created in the Windows NT™
operating system, the following user directories are automatically
created when the LCS software is first started:
1. Instrument Parameter Settings
In this directory, user-defined and predefined instrument
parameters are stored.
For a definition of user-specific instrument parameters, see
chapter "Defining user-specific instrument parameter sets".
2. Macro
In this directory, user-defined and predefined macros are stored.
For a definition of user-specific macros and information about
how to run predefined macros, see chapter "The LCS macro
language".
3. Control Panel Templates
In this directory, user-defined and predefined control panel
configurations are stored.
4. Profile
In this directory, user-settings for the graphical user interface are
stored. They include:
1. The type and position of buttons
2. The type and position of toolbars.
5. Templates
In this directory, user-defined and predefined templates for the
Viewer window are stored.

10.8 Defining user-specific instrument
parameter sets
Predefined instrument parameters are provided for typical
applications. They can be found in the "Beam Path Setting"
dialog in the "Leica" directory and have been given descriptive
names. For example, FITC_TRITC_CY5 is an acquisition mode
that detects three channels simultaneously. When this parameter
set is selected, the excitation wavelengths, their intensity and the
position and width of the detection bands are automatically set
according to the characteristics of the named fluorochromes.

Version: RK26042000
Page 83

Note
The predefined instrument parameters cannot be overwritten.
They provide a defined set of standard values.

Dialog for listing instrument parameters

10.8.1 Creating new user-specific instrument
parameters
1. Open the Beam Path Setting dialog.
2. Set the required instrument parameters.
For further information about the individual elements of the
dialog window, see chapter "Setting the Beam Path" in the online
help.
3. Click the Save button to save the set of new instrument
parameters.

10.8.2 Modifying an existing set of userspecific instrument parameters
1. Open the Beam Path Setting dialog.
2. Open the parameter set that you want to modify. It is
advisable to choose a parameter set that is most like the one
you want to create.
2. Modify the appropriate instrument parameters.
For further information about the individual elements of the
dialog window, see "Setting the Beam Path" in the online help.
3. Click the Save button to save the set of changed instrument
parameters.

Version: RK26042000
Page 84

Note
When you change an existing set of instrument parameters, you
should save the changed settings under a new name. Otherwise
the original data is overwritten with the new parameters.

10.9 User-specific customization of the
control panel
With the control panel, important scan parameters can be
defined and modified directly during operation. Each button on
the control panel controls one scan parameter.
The assignment of buttons to scan parameters is predefined.
However, this assignment can be changed by the user and the
changes saved in a panelbox template.

10.9.1 Creating control panel templates
1. In the View menu, choose Status Bars and then Control
Panel Status Bar.
The status bar for the control panel appears at the bottom of the
Leica Confocal Software user interface. From left to right, the
status bar contains the control panel icon, seven fields
representing the rotary buttons on the control panel, and three
buttons.
2. Click one of the fields representing the rotary buttons on the
control panel.
A list appears in which you can choose the desired function. The
name of the assigned function is shown in the field.
3. When you have assigned functions to all rotary buttons, you
can save this configuration in a template.
4. Click the left of the three buttons at the right edge of the
control panel's status bar.
In the dialog that now appears, enter a name for the
configuration and save it.

10.9.2 Loading a control panel template
1. To select and load a configuration, click on the middle button.
Beside the user-defined configurations, the list also contains
additional predefined configurations.
2. Click the right of the three buttons at the right edge of the
control panel's status bar.
A dialog appears in which all existing control panel
configurations are listed.

Note
The predefined configurations, which are marked "L" (Leica),
cannot be modified. The user-defined configurations are created
under User in the list and are marked "U" (User).
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If you click one of these configurations and then press the right
mouse button, a context menu containing additional commands
appears:
For further information, see chapter "Controlling functions with
the control panel".

10.10
User-defined button
assignment
All buttons available in the LCS software can be assigned to
toolbars.
This allows different functions to be made available to different
user levels. For example, only those buttons required for
currently used scan functions can be assigned to a toolbar, while
default values are used for the remaining functions.

Note:
Button and toolbar assignments can be changed only when the
LCS software is started in "Personal" mode. In "Company"
mode, these modifications are not possible.

10.10.1

Adding new buttons to a toolbar

1. In the menu, select Tools->Customize.
2. Select the Commands tab.
3. Left-click the button you want to add and drag it to the
appropriate toolbar.

Note
The position at which the button will be added is indicated by a
red cross.

10.10.2

Removing buttons from a toolbar

1. In the menu, select Tools->Customize.
2. Select the Commands tab.
3. Left-click the button to be removed and drag it into the recycle
bin on the Customize dialog.

10.10.3

Creating a new toolbar

1. In the menu, select Tools->Customize.
2. Select the Toolbars tab.
3. Click New toolbar.
4. Enter a name for the new toolbar and click OK to confirm.
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10.10.4

Deleting a toolbar

1. In the menu, select Tools->Customize.
2. Select the Toolbars tab.
3. In the list of toolbars, select the toolbar to be deleted.
4. Confirm the deletion with Yes or cancel with No.

10.10.5

Renaming a toolbar

1. In the menu, select Tools->Customize.
2. Select the Toolbars tab.
3. In the list of toolbars, select the toolbar to be renamed.
4. Enter a new name for the toolbar and click Yes to confirm or
cancel with No.

10.10.6

Moving a toolbar

Anchored toolbars have two vertical lines at their left edge.
1. Click these lines with the left mouse button and keep the
button pressed.
2. Now drag the whole toolbar to its new position.
3. Release the mouse button.

10.11
Customizing the Viewer
window
To configure the Viewer window, click on the window with the
right mouse button.
For a description of the individual configuration options, see
chapter "Viewer window".

10.12

Saving a user-defined profile

You can save user-defined user interface layouts.
The elements that are saved are the configuration of the Viewer
window, the type, position and size of toolbars and the type and
position of toolbar buttons.
To save a profile:
1. In the menu, select Tools->Customize.
2. Select the Profile tab.
3. Select Save Profile as....
4. Enter a new name for the toolbar and click Save or cancel the
operation with Cancel.

10.13
Loading a user-defined
profile
Saved user-defined user interface profiles can be reloaded when
the LCS software is started.
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1. Start the LCS software.
2. In the start window, click the outer right button next to the
Cancel button.
3. Select Load Special Profile....
4. In the dialog that now opens, choose the desired profile.

Note
Profiles can also be saved outside the default directory. In this
case, you must also select the path of the profile in the dialog.

10.14
Saving the Viewer Window as
a Template

Function
Use the Template button to save a user-defined layout of the
Viewer window as a template. The elements of the Viewer
window which can be displayed or hidden, are the button pads,
the color bars of the color look-up tables and the Experiment
legend.
 see The Viewer Window
Clicking the Template button opens a dialog window where you
enter a name for the template. The configuration of the Viewer
window is saved and always loaded if you open a file or create a
new experiment.
Additional Information
Click Options in the Tools menu and then select the Viewer
Template register to get access to default and user-defined
templates. You can select one of the following default templates
in the Leica Templates list field:
Viewer Template

Layout

Viewer (Pure)

The viewer window consists of the image window, only.

Viewer (LUT)

The viewer window consists of the image window and the color bars of the
color look-up tables.

Viewer
(Standard)

The viewer window consists of the button pads, the image window, the
color bars of the color look-up tables and the Experiment legend.
In the Personal Templates list field, user-defined templates are
registered. Use the buttons Add Active Viewer and Remove
Template to save a new template or to delete an existing one.
Click Options in the Tools menu and then select the Workspace
register to define whether, and if, how many Viewer windows are
to be opened at start-up of the Leica Confocal Software.
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11 Glossary
Aberration, chromatic

An optical image distortion conditional on the varying refraction
of light rays of different wavelengths on a lens. Thus light rays
of shorter wavelengths have longer focal distances than light
rays of longer wavelengths.

Aberration, spherical

An optical image distortion conditional on the varying distance
of paraxial light rays of the same wavelength from the optic axis.
Light rays that travel through outer lens zones have shorter
focal distances than rays that travel through the lens center
(optic axis).

Achromat (achromatic
objective)

Describes a correction class for objectives. The chromatic
aberration for two wavelengths is corrected for objectives of this
type. Usually an objective of this type is corrected to a
wavelength below 500nm and above 600nm. Furthermore, the
sine condition for one wavelength is met. The image curvature
aberration is not corrected.

Airy disc

The Airy disc refers to the inner, light circle (surrounded by
alternating dark and light diffraction rings) of the diffraction
pattern of a point light source. The diffraction discs of two
adjacent object points overlap some or completely, thus limiting
the spatial resolution capacity.

Aliasing

An image distortion caused by a sampling frequency that is too
low in relation to the signal frequency.

AOTF
Acousto-Optical
Tunable Filter

The acousto-optical tunable filter is an optic transparent crystal
that can be used to infinitely vary the intensity and wavelength
of radiated light. The crystal generates an internal ultrasonic
wave field, the wavelength of which can be configured to any
value. Radiated light is diffracted vertically to the ultrasonic
wave field like through a grid.

Aperture, numerical

The aperture is the sine of the angle under which light enters
into the front lens of a microscope objective; its symbol is NA.
The aperture influences both the light gathering capacity and
the resolution capacity of an objective. Since various media can
be present between specimen and objective lens (such as the
embedding medium for the specimen), the numerical aperture
(NA = n * sin α) is usually applied as the unit of measurement
for the light gathering capacity and the resolution capacity.

Apochromat
(apochromatic
objective)

Describes a correction class for objectives. The chromatic
aberration for three wavelengths is corrected for objectives of
this type (usually 450nm, 550nm and 650nm) and the sine
condition for at least two colors is met. The image curvature
aberration is not corrected.

Bleaching, optical

The destruction of fluorochromes by intense lighting. In
fluorescence microscopy, fluorochromes are excited with laser
light to a high state of energy, the singlet state. When the
excited molecules return to their normal energy state, a
fluorescent signal is emitted If the intensity of the excitation is
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too high however, the color molecules can change via
intercrossing from a singlet state to a triplet state. Due to the
significantly longer life of triplet states (phosphorescence), these
excited molecules can react with triplet-oxide and be lost for
further fluorescence excitation.
Confocality

While the optical design of conventional microscopes results in
the detection of both focussed and unfocussed image
components, the confocal principle suppresses the structures
outside of the focal plane of the microscope objective. To
achieve this pinholes are implemented in optically conjugated
locations in the optical path. They function as point light source
(excitation pinhole) and point detector (detection pinhole). The
diameter of the detection pinhole, along with the wavelength
and numerical aperture of the objective being used, determines
the axial extension of an optical section.

Curvature of image field

The curved surface to which a microscopic image is to be
clearly and distinctly mapped is described as image curvature
aberration. It is conditional on the convex shape of the lens and
makes itself apparent as an error due to the short focal
distances of microscope objectives. Here the object image is
not in focus both in the center and at the periphery at the same
time. Objectives that are corrected for image curvature
aberration are called plane objectives (plane = flat image field).

Dichroic

Dichroic filters are interference filters at an angle of incidence of
light of 45°. The transmissivity and reflectivity of dichroites
depend on a specific wavelength of light. For an RSP 510 filter
(reflection short pass), for example, the excitation light below
510 nm is reflected and the excitation light above this value is
transmitted. The transmission values are generally between
80% and 90% and the reflection values between 90% and 95%.

Double dichroic

Double dichroic filters are interference filters at an angle of
incidence of light of 45°. The transmissivity and reflectivity of
double dichroites depend on two specific wavelengths of light.
For a double dichroite DD 488/568, for example, the excitation
light at 488 nm and 568 nm is reflected and the excitation light
above these values is transmitted. The transmission values are
generally at 80% and the reflection values are between 90%
and 95%.

Dry objective

A microscopic objective used without immersion media.
Between the objective lens and the specimen is air.

Fluorescence
microscopy

A light-optical contrast process for displaying fluorescent
structures. Auto-fluorescent samples have a so-called primary
fluorescence. They do not need to be enriched with additional,
fluorescent substances. Secondary fluorescent substances, on
the other hand, have to be treated with appropriate dyes or
stains called fluorochromes. Specific dyeing methods
additionally allow the precise localization of the stained structure
elements of an object. Fluorescence microscopy allows both
potential morphological examinations and the ability to carry out
dynamic examinations on a molecular level.

Fluorite objectives

Describes a correction class for objectives Fluorite lenses are
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semi-apochromatic, meaning their degree of correction lies
between the achromatic and apochromatic.
Immersion objective

A microscopic objective, developed with the requirements for
applying immersion media. The use of incorrect or no
immersion medium with an immersion objective can lead to
resolution loss and impairment of the correction.

Neutral filter

Neutral filters are semi-reflective glass plates. They are used to
distribute the light path independent of wavelength. The incident
light is partially reflected and partially transmitted. Neutral filters
are usually placed at a 45° angle in the path of the beam. The
ratings of a neutral filter are based on its reflectivity-totransmissivity ratio. A neutral filter RT 30/70, for example,
reflects 30% of the excitation light and transmits 70%.

Pixel

An acronym based on the words, picture and element. A pixel
represents the smallest, indivisible picture element in a twodimensional system. In this documentation, both the sampling
points of the specimen as well as the picture points are referred
to as pixels.

Plan objectives, flatfield
objectives

Describes a correction class for objectives. The image curvature
aberration is corrected for objectives of this type. Correcting this
error requires lenses with stronger concave surfaces and thicker
middles. Three types of plan objectives, planachromate,
planapochromate and plan- fluorite, are based on the type of
additional correction for chromatic aberration.

Reflection short pass
filter

Reflection short pass filters are interference filters that transmit
short-wave light while reflecting long-wave light. An optical
reflection short pass filter is characterized by the reading of the
wavelength edge at which the filter changes from transmission
to reflection (50% threshold).

Reflection long pass
filter

Reflection long pass filters are interference filters that reflect
short-wave light but are transparent for long-wave light. An
optical reflection long pass filter is characterized by the reading
of the wavelength edge at which the filter changes from
reflection to transmission (50% threshold).

Refractive index

The factor by which the light velocity in an optical medium is
less than in a vacuum.

Signal-to-noise ratio

The ratio of signals detected in the specimen and the unwanted
signals that are caused randomly by various optic and electronic
components, which are also recorded by the detector.

Stokes shift

The Stokes shift is a central term in fluorescence microscopy.
When fluorescent molecules are excited with light of a specific
wavelength, they radiate light of another, longer wavelength.
This difference between excitation light and fluorescent light is
referred to as Stokes shift. Without Stokes shift, separating the
high-intensity excitation light from the low-intensity fluorescence
signals in a fluorescence microscope would not be possible.

Triple dichroic

Triple dichroic filters are interference filters at an angle of
incidence of light of 45° The transmissivity and reflectivity of
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triple dichroites depend on three specific wavelengths of light.
For a triple dichroite TD 488/568/647, for example, the
excitation light at 488 nm, 568 nm and 633 nm is reflected and
the excitation light above these values is transmitted. The
transmission values are generally at 80% and the reflection
values are between 90% and 95%.
Voxel

An acronym based on the words, volume and pixel. A voxel
represents the smallest, indivisible volume element in a threedimensional system. In this documentation, both the volume
elements of the specimen as well as the 3D picture points are
referred to as voxels.

Working distance

The distance from the front lens of an objective to the focal
point. The free working distance is defined as the distance
between the front lens of the objective and the cover slip or
uncovered sample. Usually objectives with large working
distances have low numerical apertures, while high-aperture
objectives have small working distances. If a high-aperture
objective with a large working distance is desired, the diameter
of the objective lens has to be made correspondingly large.
These, however, are usually low-correction optic systems,
because maintaining extreme process accuracy through a large
lens diameter can only be achieved with great effort.
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